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1 IMPORTANT INFORMATION 

For your protection, carefully read these instructions before installing and operating the scan 

head.  

Retain these instructions for future reference.  

Novant reserves the right to update this user manual at any time without prior notification.  

If product ownership changes, this manual should accompany the product. 

1.1 SAFETY SYMBOLS 

This manual uses the following symbols and signal words for information of importance. 

 DANGER 

Indicates a hazardous situation which, if not avoided, will result in serious injury or death. 

 

 WARNING 

Indicates a hazardous situation which, if not avoided, could result in serious injury or death. 

 

 CAUTION 

Indicates a hazardous situation which, if not avoided, could result in minor or moderate injury. 

 

 IMPORTANT 

Indicates information considered important but not directly hazard related (e.g. security, hygiene, 

or equipment or property damage). 
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1.2 SAFETY LABELS 

 DANGER  

Laser radiation  

can cause severe retinal and corneal burns, burns on the skin, and may pose a fire risk.  

¶ To avoid injury and reduce risk of fire, please follow the control measures and safety 

ƎǳƛŘŜƭƛƴŜǎ ǇǊƻǾƛŘŜŘ ōȅ ǘƘŜ ƭŀǎŜǊΩǎ manufacturer, and those established by your Laser Safety 

Officer (LSO), Radiation Safety Officer (RSO), or safety department of your business or 

institution. 

 

 

 ESD WARNING 

Electrostatic discharge and improper handling  

Ŏŀƴ ŘŀƳŀƎŜ ah±L! ǎŎŀƴ ƘŜŀŘΩǎ ŜƭŜŎǘǊƻƴƛŎǎΦ 

¶ Keep the equipment sealed until it is located at a proper static control station. 

 

1.3 CUSTOMER SUPPORT 

Before contacting Novanta for assistance, review appropriate sections in the manual that may 

answer your questions.  

After consulting this manual, please contact one of our worldwide offices between 9 AM and 5 PM 

local time. 

Americas, Asia Pacific 

Novanta Headquarters, Bedford, USA 

Phone: +1-781-266-5700 

Email: photonics@novanta.com 

mailto:photonics@novanta.com
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Europe, Middle East, Africa 

Novanta Europe GmbH, Wackersdorf, Germany 

Phone: +49 9431 7984-0 

Email: photonics@novanta.com 

Milan, Italy 

Phone: +39-039-793-710 

Email: photonics@novanta.com 

China 

Novanta Sales & Service Office, Shenzhen, China 

Phone: +86-755-8280-5395 

Email: photonics.china@novanta.com 

Novanta Sales & Service Office, Suzhou, China 

Phone: +86-512-6283-7080 

Email: photonics.china@novanta.com 

Japan 

Novanta Service & Sales Office, Tokyo, Japan 

Phone: +81-3-5753-2460 

Email: photonics.japan@novanta.com 

 

 

mailto:photonics@novanta.com
mailto:photonics@novanta.com
mailto:photonics.china@novanta.com
mailto:photonics.china@novanta.com
mailto:photonics.japan@novanta.com


Introduction 

Version 3.2, Revision H 

2 INTRODUCTION 

2.1 GENERAL NOTES 

Novanta reserves the right to make changes to the products covered in this manual to improve 

performance, reliability or manufacturability. 

Although every effort has been made to ensure accuracy of the information contained in this manual, 

Novant assumes no responsibility for inadvertent errors. Contents of the manual are subject to 

change without notice. 

2.2 SCANMASTER ARCHITECTURE 

ScanMaster Designer is a powerful software application that is designed to support Novanta's Scan 

Controllers. With ScanMaster Designer you can create and scan virtually any image using text, linear 

barcodes, 2D data matrix barcodes, QR-Codes, or imported graphics. ScanMaster Designer also 

features ScanScript, a powerful scripting language with a comprehensive library of commands for 

supporting any laser scanning scenario. 

The ScanMaster Designer user interface provides the following:  

¶ Object design with easy-to-use CAD features  

¶ Barcode marking  

¶ Vector/Raster image marking 

¶ Image processing features  

¶ True Type® and Ovf font support 

¶ Automatic Date and Serial Number Generation  

¶ Digital input/output capabilities  

¶ Comprehensive help files on CAD and ScanScript commands  

Once you have selected your Novanta scan head, you can select your Scan Controller and software. 

NovantaΩǎ ǎǳƛǘŜ ƻŦ ǎŎŀƴ ŎƻƴǘǊƻƭ ǇǊƻŘǳŎǘǎ ŜƴŀōƭŜǎ ȅƻǳ ǘƻ ǎȅƴŎƘǊƻƴƛȊŜ ƳƛǊǊƻǊ Ƴƻǘƛƻƴ ǿƛǘƘ ƭŀǎŜǊ firing 
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and integrate these products with your own software and hardware. ScanMaster Designer supports 

the ScanMaster Controller (SMC). The SMC can be controlled with either the ScanMaster Application 

Programming Interface (SMAPI) or ScanMaster Designer. 

ScanMaster Designer is user software with a ŎƻƴǘŜƳǇƻǊŀǊȅ άlook ŀƴŘ ŦŜŜƭέ ŀƴŘ ŀƭƭ ǘƘŜ ŦǳƴŎǘƛƻƴŀƭƛǘȅ 

you need to create and control your scan jobs. Its intuitive graphic design environment, import 

capabilities, and editing tools make job creation easy. ScanMaster Designer is well-suited for system 

integrators and small-volume OEM runs. 

SMAPI provides most of ScanMaster 5ŜǎƛƎƴŜǊΨǎ scanning functionalities for use with your own user 

interface. This high-level API will allow you to programmatically incorporate complex objects (such as 

1D and 2D barcodes, fonts, arcs, circles and more) into your scanning jobs. This API also supports 

ScanScript, Novanta's scripting language that enables complex job structures and flow control. 

The following diagram is a visual representation of the ScanMaster architecture. It shows how 

ScanMaster Designer connects to the Scan Controllers and other scanner products. 
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FIGURE 1: SCANMASTER ARCHITECTURE 
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2.3 DOCUMENT CONVENTIONS PROJECT CONCEPTS 

A job is represented in ScanMaster Designer as a Project. A Project consists of two entitiesτThe 

Script and the Image. 

 

FIGURE 2: PROJECT CONCEPT 

An Image is a drawing that is made up of one or more Layers that hold shapes and other elements 

(text strings, barcodes and pictures). Layers simplify the creation of complex images and are used to 

define the order of execution. Each Image is associated with its own set of laser properties. Layers 

ǳǎǳŀƭƭȅ ƛƴƘŜǊƛǘ ǘƘŜ ǇŀǊŜƴǘ ƛƳŀƎŜΩǎ ǇǊƻǇŜǊties but can also be associated with their own set of laser 

properties. 

Though seemingly similar, layers only exist in the context of the image they are part of, while images 

are addressable entities that can be selected for individual execution or manipulated by the script. 

Apart from one or more images, the project virtually contains one Composite Image, which is made 

up of all the drawings in the different images. The Composite Image helps you align and arrange the 

drawings in the various images to optimize the output prior to execution. 

The Script entity is used to provide execution of flow control, to support integration with the rest of 

the system, and to allow programmatic manipulation of Images and settings.There is no restriction 

on the number of Images and Scripts in a Project. The tabs on the right side of the Drawing Canvas 

provide a means to select an Image or the Script, as well as a visual indication of the available Images 

and the currently active one. 

ScanMaster Designer offers a graphical representation of this hierarchical structure through the 

Project Explorer window (Scripts and Images) and the Shape Tree window (Layers and Shapes). 
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2.4 SCAN CONTROLLERS 

ScanMaster Designer supports the following Scan Controllers from Novanta: 

SMC ς The SMC is a self-contained controller that provides advanced hardware and software control 

technology to drive laser scanning systems. The SMC control board is specifically designed for remote 

embedding and control of a scan head and laser system. It is capable of controlling two scan heads, 

each with up to three motion axes, with concurrent laser timing control. The SMC also provides 

integrated synchronization I/O for connection to factory automation equipment.  The SMC also has 

the ability to interface directly with LightningTM II digital scan heads.  It also supports integrated 

ScanPack sky-writing capability for those heads.  It is a more modular design supporting a wide 

variety of lasers using specialized laser adapters and cables. 

 

2.5 USING SCANMASTER DESIGNER HELP 

The online help for ScanMaster Designer includes a comprehensive table of contents and a full text-

search capability, to help you find information for using the product. 

Book icons open to reveal sub-books and topics. Double-click on a book icon to expand the table of 

contents and view topics inside the book. When you double-click a book icon that is already 

expanded, the topics will be hidden. The left side of the window displays the table of contents, and 

the right-side pane displays information relevant to the selected topic. You may use the Back and 

Forward buttons on the toolbar to navigate through the pages. 

Finding a Help Topic 

The following Browse and Search options are available through the ScanMaster Designer Help: 
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2.5.1 Contents tab 

1. Click the Contents tab to browse through the table of contents. 

2. Double-click the Book Icons to reveal sub books and topic entries. 

3. Click on the desired Table of Contents entry to view the topic. 

 

FIGURE 3: THE CONTENTS TAB OF THE SCANMASTER DESIGNER ONLINE HELP WINDOW 
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2.5.2 Index tab 

1. Click the Index tab to browse through the index entries. 

2. Type the keyword or topic you wish to search. 

3. Double-click on the desired Topic from the list of results to display the topic entry. 

 

FIGURE 4: THE INDEX TAB OF THE SCANMASTER DESIGNER ONLINE HELP WINDOW 

 

 

 

 

 

 

 



Introduction 

Version 3.2, Revision H 

2.5.3 Search tab 

1. Click the Search tab and enter a word or a phrase to search for.  

2. Click List Topics. The search results will be displayed under Select Topic to display section. 

3. Select the relevant topic and click Display.  

 

FIGURE 5: THE SEARCH TAB OF THE SCANMASTER DESIGNER ONLINE HELP WINDOW 

2.5.4 Favorites tab 

1. Click the Add button on the Favorites tab. 

2. The Topics section will display the links to the topics that you have added to your Favorites. 

3. If you select a topic and click Display, the topic opens to the right. 

 

FIGURE 6: THE FAVORITES TAB OF THE SCANMASTER DESIGNER ONLINE HELP WINDOW 
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2.5.5 Printing a Help Topic 

1. Select the help topic you wish to print. 

2. In the Help window, click Print . 

3. Select the desired printing options; you may print just the selected topic or the selected topic 

and all its subtopics. 

4. Click the Print button. 

 

FIGURE 7: THE PRINT BUTTON 

2.5.6 Copying Examples 

In "How to script in ScanScript" you will find useful script codes. Use these examples to learn and 

understand ScanScript methods. To copy and use these examples: 

1. Click the Copy button on the example box header. 

2. Paste them on the ScanScript editor by pressing Ctrl + V or by right-clicking and selecting 

Paste. 
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3 GETTING STARTED  

This Section describes how to install and start the ScanMaster Designer application. This section also 

introduces key features of the program and provides tips for establishing a good workflow.  

3.1 SYSTEM REQUIREMENTS 

The following are the minimum requirements for installing and running ScanMaster Designer on your 

computer: 

¶ Processor: 1GHz 

¶ Memory: 4 GB 

¶ Hard Disk Space: 1GB 

¶ Display: 1024 x 768 High Color (16-bit) 

¶ Windows 7 or Windows XP Professional with Service Pack 2 or higher 

 

3.2 SCANMASTER DESIGNER INSTALLATION 

3.2.1 To install ScanMaster Designer 

Do the following to install ScanMaster Designer on your computer: 

1. Run the ScanMaster Designer Installer.exe by double clicking on it.  

2. You will see the following screen. 
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FIGURE 8: THE SCANMASTER DESIGNER SETUP WIZARD 

3. Click Next to begin the installation process. The License Agreement will be presented. You 

are advised to read the terms of the license carefully before proceeding with the installation. 

If you decline the license terms, the installation cannot proceed. Click I Agree to proceed 

with the installation.  

4. At this point of the installation process, you cannot change the destination folder of 

ScanMaster Designer. To change the destination folder, select the new folder and click Next. 

Note:  Changing the destination folder is not recommended unless you have specific reasons for 
doing so. 
5. Select the Scan Controller you want to use with ScanMaster Designer and click Next.  

6. Now you see the Ready to Install page. You can verify that you have provided accurate 

information and click Install. Otherwise, you can go back and provide accurate information. 

After the installation has completed, you will be required to restart your machine. 
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3.2.2 Uninstalling ScanMaster Designer 

To uninstall ScanMaster Designer, go to Start in the lower left hand corner of your computer screen 

and select All Programs and then the Novanta ŦƻƭŘŜǊΦ LƴǎƛŘŜ ǘƘŀǘ ŦƻƭŘŜǊ ƛǎ ŀ ŦƛƭŜ ƴŀƳŜŘ Ψ¦ƴƛƴǎǘŀƭƭΩΦ 

Click on this file to invoke the uninstallation process. This takes a few seconds. 

 

 

 

FIGURE 9: UNINSTALLING SCANMASTER DESIGNER 
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1. Left-click the Uninstall button in the following screen. 

 

FIGURE 10: THE UNINSTALL DIALOG BOX 

3.2.3 Repairing or ScanMaster Designer 

In order to repair ScanMaster Designer, you must locate the original installer program used to install 

the software. 

1. Double-click on the installer program icon to display the following screen. 

 

FIGURE 11: THE SCANMASTER DESIGNER SETUP WIZARD 

2. Select the Repair option and click Next, and click Install in next screen that is displayed. 
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3.3 STARTING SCANMASTER DESIGNER 

You can start ScanMaster Designer from your desktop or from your Start Menu. 

3.3.1 Starting ScanMaster Designer from Your Desktop 

To start ScanMaster Designer from your desktop, double-click the following shortcut. 

 

FIGURE 12: THE SCANMASTER DESIGNER DESKTOP SHORTCUT 

3.3.2 Starting ScanMaster Designer from Your Start Menu 

To start ScanMaster Designer from your Start Menu, do the following: 

1. Left-click the Start button on your Windows taskbar. 

 

FIGURE 13: THE START BUTTON ON THE WINDOWS TASKBAR 

               This displays the Start menu. 

2. Select Programs and locate the Novanta folder and then locate the ScanMaster 

Designer sub-folder. 

3. Click the ScanMaster Designer  icon.  

 

 

 

 

 

                                                                                  FIGURE 14: THE WINDOWS START MENU 
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The following window will appear. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

FIGURE 15: THE START-UP SCREEN 

 

To start a new project, click New from the Home tab.  

To open an existing project, click Open  from the Home tab.  

A basic marking job is created by placing different shapes such as text, geometric shapes, and 

barcodes on the Drawing Canvas. Each shape has its unique properties, which can be modified. 

In addition, laser marking properties are available to precisely control the marking dimensions. 

{ŜŜ άSection 5: Managing Projectsέ ŦƻǊ ŘŜǘŀƛƭŜŘ ƛƴŦƻǊƳŀǘƛƻƴ ŀōƻǳǘ ŎǊŜŀǘƛƴƎ ǇǊƻƧŜŎǘǎΦ 
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3.4 EXITING SCANMASTER DESIGNER 

To exit ScanMaster Designer, click the Exit button   in the lower-right corner of the File 

menu. 

 

FIGURE 16: THE EXIT BUTTON ON THE FILE MENU 
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3.5 WORKSPACE ELEMENTS 

The following figure contains an overview of the Graphical User Interface (GUI) elements of 

ScanMaster Designer. 

 

FIGURE 17: WORKSPACE ELEMENTS 

3.6 RECOMMENDED WORKFLOW 

1. Create a Job. ! άWƻōέ ƛǎ ŀ ǎƛƳǇƭŜ ǇǊƻƎǊŀƳ ǘƘŀǘ Ŏƻƴǘŀƛƴǎ LƳŀƎŜǎ ŀƴŘ ŀ {ŎǊƛǇǘ ǘƘŀǘ ŀǊŜ ŜȄŜŎǳǘŜŘ 

in the prescribed order. Click New to create a job from scratch or click Open  to load 

an existing job. 

2. Design and edit with Drawing Shapes Tools. 
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3. Insert a shape. 

To insert a shape, click its icon in the Drawing Shapes Toolbar. Some tools in the Drawing Shapes 

Toolbar have additional hidden tools, as indicated by the small triangle to the lower right of the 

shape icon. To select a hidden tool, click on the triangle and the Shapes List appears. Then, click 

the option you want. 

4. Select a shape. 

Before you can edit a shape, you must first select it. To select multiple shapes, use any of the 

following options: 

¶ Ctrl + A to select all shapes in the current image. 

¶ Shift + Click to add a shape to the selection. 

¶ Click and drag over a region to select shapes that are completely included (top-left to 

lower-right, blue region) or partially included (lower-right to top-left, green region). 

5. Edit and modify shapes. 

The ScanMaster Designer is equipped with a rich collection of editing tools that you can use to 

edit your image. The Tools and Arrange options on the Ribbon will allow you to edit and modify 

shapes. 

6. Arrange complex jobs into a simple hierarchy (Projects, Images, Layers, and Shapes). 

Shapes placed in an Image can be grouped into Layers in the Shape Tree. Each Layer can contain 

many Shapes. Grouping Shapes into Layers will allow you to establish a proper marking order. 

You can work on many Images at any given time. The hierarchy of the Images and the Scripts can 

be viewed from the Project Explorer tab.  You can also change the current project settings from 

this panel. 

7. Set Shape and Laser properties. 

When a Shape is selected, its geometrical properties such as the X and Y coordinates, width, 

height, and laser settings will be listed in the Properties window of the ScanMaster Designer 

window. You can access and edit these properties as desired.  

8. Save projects. 

When you use the Save command, ScanMaster Designer saves Project and Shapes information to 

the current project file. However, when you use the Save As command, ScanMaster Designer 

rewrites the project/shapes information into a new file. While working with the ScanMaster 

Designer, save projects frequently and create backup copies of important files. The Auto 
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Recovery setting in the application preferences enables ScanMaster Designer to automatically 

save a copy of the current workspace for specified time period. This may be used to recover a file 

in case an unexpected application crash occurs. 

9. Connect to the Controller. 

ScanMaster Designer supports multiple Scan Controllers. In order to start the execution of a job, 

you need to first connect to a specific Scan Controller. Click the Devices tab to see a list of 

available Scan Controllers.  Click on the device you wish to select and then press Connect. 

Once you connect to a particular Scan Controller, the Connect button will be disabled and the 

buttons in the Mark group will be enabled. 

10. Execute/Download the job. 

Run, pause and stop marking 

¶ Click Start  to activate the marking process. 

¶ Click Pause  to pause the marking. (Please note that some of the Scan Controllers do 

not support the pause operation.) 

¶ Click Stop  to terminate the marking process. 

Tracing Shapes and aligning parts 

If the system has a guide laser pointer, do the following: 

¶ Click Trace  to trace the current Job. This will give you an idea of how the laser moves 

during the actual marking. 

¶ Click Align  ǘƻ ǘǊŀŎŜ ǘƘŜ ōƻǳƴŘƛƴƎ ōƻȄ ƻŦ ǘƘŜ ŎǳǊǊŜƴǘ WƻōΩǎ /ƻƳǇƻǎƛǘŜ LƳŀƎŜ όǘƘŜ 

maximum extent of all the shapes) to help you identify the area of the actual marking. 

This is useful for part aligning. 

¢ƘŜ ƎǳƛŘŜ ƭŀǎŜǊΩǎ {ǇŜŜŘ ŀƴŘ wŜǇŜǘƛǘƛƻƴ /ƻǳƴǘ ŀǊŜ ǎŜǘ ƛƴ Preferences. 

Downloading Jobs 

If the connected scan controller has an on-board flash memory, you can download the job for 

future execution by clicking Download . 
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3.7 JOB CREATION EXAMPLE 

In the following example, we create a Rectangle and a Circle for marking: 

1. Create a new Project by clicking on the New button on the Home tab.  

2. Place a Rectangle and a Circle on the Drawing Canvas. These tools can be found in the 

Drawing Shapes Toolbar. 

First click Insert Rectangle . You can place the rectangle anywhere on the Drawing Canvas. 

To do that, click with the mouse at the appropriate coordinates within the view and hold it 

ŘƻǿƴΦ bƻǿ ŘǊŀƎ ǘƘŜ ƳƻǳǎŜ ǘƻ ǘƘŜ Ǉƻǎƛǘƛƻƴ ȅƻǳ ǿŀƴǘ ǘƻ ǎǇŜŎƛŦȅ ŀǎ ǘƘŜ ǊŜŎǘŀƴƎƭŜΩǎ ƻǇǇƻǎƛǘŜ 

corner and release the mouse. 

3. Follow the same procedure to draw a Circle. 

4. If you wish to edit the shape properties (position, size, etc.) of the rectangle or the circle, you 

can do so by clicking on the Properties tab on the lower right panel on the screen.  

5. If you wish to edit the properties of the laser, click the Laser Properties tab on the lower-right 

panel on the window.  

6. Once you make the necessary changes, save your project.  

7. Connect to the Scan Controller. 

8. Click the Devices tab on the upper right panel on the screen. Select the relevant Scan 

Controller and click Connect . Once you connect to the card, the Mark group on the 

Ribbon will bet enabled. (See Chapter 9: Hardware related operations for other laser marking 

operations.) 

9. Scan Shapes.  

Click Start to activate the marking process.  

 

 

 

 

 

                                                                                                      FIGURE 18: EXAMPLE 
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3.8 WHAT IS LASER MARKING? 

3D laser marking refers to the laser marking performed on a 3D workspace. 3D laser marking 

comprises a range of 3D related processes including all types of Surface Markings, Engraving, Sub 

Layer Laser Engraving and Prototyping. 3D laser marking technology is widely used by many 

industries such as packaging, automobile manufacturing, jewelry and etc. 

{ŎŀƴaŀǎǘŜǊϰ 5ŜǎƛƎƴŜǊ software allows you to create a digital 3D model and apply 2D images to a 3D 

surface.  This application facilitates 3D marking with either projection or wrapping styles. 

This application also enables you to do laser engravings by specifying different sections and layers. 

More detailed information about these features will be discussed in this document. 

The marking procedure can be customized using the ScanScript language in which you can 

experience the advanced capabilities not available through the user interface.  

 

Note:  A detailed description about Projection and Wrapping styles and their differences will be 

discussed in the appendix of this document. Refer Appendix A of this document. 

3.9 SCAN CONTROLLER CARDS 

There are four different Scan Control cards available which are supported by {ŎŀƴaŀǎǘŜǊϰ 

Designer software:  

1. ScanMaster Controller - The SMC is a self-contained controller that provides advanced 

hardware and software control technology to drive laser scanning systems. The Ethernet-

connected SMC board is designed to permit remote embedding and control of a scan-head 

and laser system. It is capable of controlling two scan-heads with up to three motion axes 

each with concurrent laser timing control. It also provides integrated synchronization I/O for 

connection to factory automation equipment. 

2. EC1000 - The EC1000 is a self-contained controller that provides advanced hardware and 

software control technology to drive laser scanning systems. The EC1000 control board is 

specifically designed for remote embedding and control of a scan-head and laser system. It is 

capable of controlling two scan-heads with up to three motion axes each with concurrent 

laser timing control. It also provides integrated synchronization I/O for connection to factory 

automation equipment. The EC1000 controller card is the core of the SM1000 Controller 

Module. 
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4 THE SCANMASTER DESIGNER INTERFACE 

4.1 THE FILE TAB 

The File tab provides easy access to some of the most commonly used commands and 

recently used Projects. The tab is located in the upper-left corner of the ScanMaster Designer 

window.  

Clicking on the File tab displays a vertical list of options. Select an option to launch the associated 

command. In addition to command access, the File tab enables you to view and access recently 

opened documents and pin documents to the Recent Documents list for quick access. To pin an item 

to the Recent Items, click the pin icon  next to the relevant file name. Note that the Pin option is 

toggle-able, where   indicates an item that is not currently pinned and  indicates that it is 

pinned. 

 

 

 

 

 

 

 

 

FIGURE 19: THE DESIGNER START BUTTON 
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4.2 QUICK ACCESS TOOLBAR 

The Quick Access Toolbar is helpful for accessing frequently used tools in ScanMaster Designer.  By 

default it is disabled and in Quick Access Toolbar 

The Quick Access Toolbar is helpful for accessing frequently used tools in ScanMaster Designer.  By 

default it is disabled and invisible until an item is added as shown in the following section. When first 

enabled, it is placed at the top of the ScanMaster Designer window, next to the ScanMaster Designer 

icon and is always available to the user, regardless of which tab is selected in the Ribbon. Also, you 

can place the Quick Access Toolbar below the Ribbon by selecting that option from the right-click 

menu.  

 

 

 

FIGURE 20: THE QUICK ACCESS TOOLBAR 

4.2.1 Customize the Quick Access Toolbar 

To add a command to the Quick Access Toolbar, right-click the command, and then select Add to 

Quick Access Toolbar from the menu.  

 

 

 

 

FIGURE 21: ADDING A COMMAND TO THE QUICK ACCESS TOOLBAR 

To remove a command from the Quick Access Toolbar, right-click it and then select Remove from 

Quick Access Toolbar from the menu. 

 

 

FIGURE 22: REMOVING A COMMAND FROM THE QUICK ACCESS TOOLBAR 
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4.2.2 Place the Quick Access Toolbar above/below the ribbon 

By default, the Quick Access Toolbar is placed at the top of the ScanMaster Designer window next to 

the File tab. If desired, you have the option to place the Quick Access Toolbar below the ribbon. 

Select Show Quick Access Toolbar below the Ribbon from the right-click menu and it will be moved 

below the Ribbon. 

 

FIGURE 23: THE PLACE QUICK ACCESS TOOLBAR MENU 

4.3 THE RIBBON 

The Ribbon provides easy access to ScanMaster Designer tools and commands that can be used to 

create and edit drawings. Tools are logically grouped into a collection of Ribbon tabs. Each tab 

contains multiple Groups, and each Group contains a set of related commands. The Ribbon is docked 

on top of the ScanMaster Designer Drawing Canvas. 

As your mouse passes over the Ribbon, tool tips will be displayed. The following figure shows the 

Ribbon for the Home tab. 

 

FIGURE 24: AN EXAMPLE OF THE RIBBON 

4.3.1 Minimize/Maximize the ribbon 

To maximize working space, you can reduce the Ribbon to see only the tabs in ScanMaster Designer. 

You can minimize the ribbon by right-clicking on the Ribbon and selecting Minimize the Ribbon from 

the menu.  
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FIGURE 25: MINIMIZING THE RIBBON 

To maximize the ribbon, right-click on the Ribbon and deselect Minimize the Ribbon again.  

The following sections describe all of the tabs that are available on the Ribbon. 

4.3.2 Home 

The Home tab on the Ribbon contains the following commands (some menu commands will be 

enabled once you connect to a Scan Controller). 

FIGURE 26: THE HOME TAB 

Standard 

The Home | Standard panel of ScanMaster Designer includes commands for creating, opening, and 

saving a new project and exporting images as .svi files. 

Icon  Command  Description  

 

New  Creates and opens a new project.  

 

Open  Opens a saved project.  

 

Save  Saves the current project.  

 

Save As  Saves the current project under a different name.  

 

Export  Exports images as .svi  files to a location on the host machine.  
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Edit 

The Home | Edit panel of ScanMaster Designer includes commands for undoing and redoing actions 

and cutting, copying, pasting, and deleting shapes in the ScanMaster Designer workspace. 

Icon  Command  Description  

 

Paste  Pastes objects that were cut or copied into the current workspace.  

 

Cut  
Cuts the selected objects from the current workspace and sends 
them to the Clipboard.  

 

Copy  Copies all selected objects to the Clipboard.  

 

Delete  Deletes all selected objects.  

 

Undo  
Reverses the last action performed. You may also undo any of the 
last few actions that were performed by clicking the arrow next to 
the Undo icon and selecting the action(s) to undo.  

 

Redo  
Re-applies the action that you undid last. You may also redo any 
of the last few actions that were performed by clicking the arrow 
next to the Redo icon and selecting the action(s) to redo.  

 

View 

The Home | View panel of ScanMaster Designer includes commands for zooming, panning, and 

rotating the Drawing Canvas in the ScanMaster Designer workspace. 

Icon  Command  Description  

 

Zoom In  Enlarges the display size of the workspace on the screen.  

 

Zoom Out  Reduces the display size of the workspace on the screen.  

 

Pan 
Allows you to quickly move around the canvas at the same 
magnification you have currently set.  

 

Rotate  Rotates the 3D Drawing Canvas.  

 

Show Field  
Zooms to display the entire Drawing Canvas field to a 
specified resolution.  

 

Fit to All  
Adjusts the zoom level to fit the entire contents of the 
drawing into the current view.  

 

Zoom Window  Offers a quick way to view a selected area of the drawing.  

 

Zoom Factor  Allows you to zoom in or out by the specified zoom factor.  

Mark 

The Home | Mark panel of ScanMaster Designer includes commands for marking, scanning, and 

downloading scanning jobs to flash memory. 
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Icon  Command  Description  

 

Start  Starts marking.  

 

Pause Pauses marking.  

 

Stop  Stops marking.  

 

Trace  Traces the outer line of the drawing.  

 

Align  Traces the bounding box of the current job.  

 

Download  
Downloads scanning jobs to flash memory in 
the controller or to USB memory.  

 

 
Scan Project  

Scans the whole project including execution of 
the script.  

 

 
Scan Active Image  Scans all of the shapes in the selected image.  

 

 

Scan Selected 
Shapes  

Scans only the shapes that you select in the 
selected image.  

 

4.3.3 Project 

The Project tab contains process automation tools and advanced marking features. 

 

FIGURE 27: THE PROJECT TAB 

Basic Elements 

The Project | Basic Elements panel of ScanMaster Designer includes commands for adding a script or 

images to the project. 

Icon  Name  Description  

 

2D Image  Adds a 2D image to the project.  

 

3D Model  Adds a 3D image to the project.  

 

Script  Adds a script to the project.  
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Import  
Imports an existing 2D image, 3D image, or Script file to the 
project.  

 

Automation 

The Project | Automation panel of ScanMaster Designer includes commands for launching the 

ScanScript Assistant and adding automation objects (Tiling, Tray, Database, or DLL) to a project.  

Icon  Name  Description  

 

Tiling  Adds a Tiling automation object to the project.  

 

Tray  Adds a Tray automation object to the project.  

 

Database  Adds a Database automation object to the project.  

 

Dll  Adds a DLL automation object to the project.  

 

ScanScript 
Assistant  

Launches the ScanScript Assistant program that provides 
functionalities to operate automation objects properly.   

Marking Process 

The Project | Marking Process panel of ScanMaster Designer includes commands for engraving and 

surface marking. 

Note:  These commands are only available if the 3D Extensions are enabled. 

Icon  Name  Description  

 

Engraving  
Creates relief impressions in a substrate. Refer to the ScanMaster 
Designer 3D Extensions Manual for more information.  

Hardware 

The Project | Hardware panel of ScanMaster Designer includes the Hardware command for creating 

and adding hardware control to the Project. 

Icon  Name  Description  

 

Hardware  Creates and adds hardware control to the Project.  
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4.3.4 Tools 

The Tools tab on the Ribbon provides the following options to modify shapes and text. 

 

FIGURE 28: THE TOOLS TAB 

Transform 

The Tools | Transform panel of ScanMaster Designer provides the following commands for moving, 

scaling, and rotating shapes. 

Icon  Command  Description  

 

Rotate  Rotates a shape around a point of reference on the canvas.  

 Scale  Changes the current size of a shape.  

 

Mirror  
Creates a symmetrical mirror image of the selected shape according 
to the specified mirror line.  

 

Move  
Moves the selected shape(s) to the new position that you specify on 
the canvas.  

 

Move to Origin  Moves the selected shape(s) to the origin of the canvas.  

 

Array 

The Tools | Array panel of ScanMaster Designer provides the following commands for creating 
and managing duplicates of a particular shape. 

Icon  Command  Description  

 

Rectangular Array  
Creates copies of a selected shape, or shapes, in rows and columns 
at a specified spacing.  

 

Polar Array  
Creates copies of a selected shape, or shapes, in a circular pattern, 
based on a specified centerpoint.  
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Modify 

Icon  Command  Description  

 

Trim  Removes a selected section from a given shape.  

 

Extend  
Extends a shape or a part of a shape to touch another shape in 
a drawing.  

 

Join  
Joins shapes that have a gap between them by using any of the 
following styles: Extend or Trim , Shift One End  or Insert 
Lines .  

 

Break  
Splits a shape into two or more parts by specifying a point on 
the shape or by drawing a line.  

 

Divide  Divides a particular shape into two or more separate parts.  

 

Explode  Breaks a shape into its primitive shapes.  

 

Group  Combines several shapes to create one shape.  

 

Fillet  
Connects two adjacent lines with an arc that is tangent to the 
object and has a specified radius.  

 

Chamfer  Connects two lines to meet in a flattened or bevelled corner  

 

Bridge  Creates a gap of a specified distance between two shapes.  

 

Hatch 

The Tools | Hatch panel of ScanMaster Designer is used to fill shapes and text with closely spaced 

parallel lines, also known as hatching. Without hatching, only the outline of the logo or the object will 

be marked. With hatching, the shape will be filled with any of the available filling styles. You can add 

more than one hatch pattern to a single drawing.  

Icon  Command  Description  

 

Line Hatch  Fills the selected shape with lines.  

 

Offset Hatch  Fills the selected shape with the Offset Hatch pattern.  

 

Offsets In/Out  Fills the selected shape with the Offsets In/Out Hatch pattern.  

 

Helix Hatch  Fills the selected shape with the Helix Hatch pattern.  

Quality 

The Tools | Quality panel of ScanMaster Designer includes commands for applying Cutter 

Compensation, removing overlapping lines, and controlling the marking quality of circular shapes. 

https://d.docs.live.net/548dfe7b0105be0e/Documents/CT%20Manuals/ScanMaster%20Designer%20User%20Manual.docx#_Ref1472179786
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Icon  Command  Description  

 

Cutter Comp.  
Applies Cutter Compensation, which is an offset that accounts for 
variations in beam width.  

 

Remove Overlaps  Removes overlapping lines.  

 

Marking Quality  Controls the marking quality of circular shapes.  

 

Lead - in/Lead -out  

Adds marking extensions to a shape to permit entering a shape 
at an angle along a straight edge.  Useful for avoiding localized 
ñhot-spotsò in foil cutting. 

 

Optimize 

The Tools | Quality panel of ScanMaster Designer includes commands for visually representing 

jumps and the marking order of shapes and optimizing marking paths and polylines. 

Icon  Command  Description  

 

Show Jumps  
Graphically represents the movements of the laser beam between 
shapes.  

 

Marking Order  
Gives a visual representation of the order in which a particular 
shape will be marked, as well as the mark's starting point.  

 

Path Optimize  
Optimizes the marking order of shapes placed on the canvas by 
decreasing the number of vector moves performed by the scan 
head, thereby reducing the cycle times.  

 

Directional 
Optimize  

Directionally optimize the marking path to match the material 
flow in mark -on - the - fly applications.  

 

Simplify Polylines  
Simplifies the polylines by removing the unnecessary vertices 
within the error limit.  
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4.3.5 Arrange 

The Arrange commands are used to locate shapes relative to each other. 

 

FIGURE 29: THE ARRANGE TAB 

Align 

The Arrange | Align panel of ScanMaster Designer includes commands for adjusting a shape in 

relation to other shapes or specifying a static orientation of a shape, or set of shapes, in relation to 

others. 

Icon  Name  Description  

 

Align Left 
Edges  

Aligns the left edge of all other selected shapes to the left edge of 
the initially selected shape.  

 

Align Right 
Edges  

Aligns the right edge of all other selected shapes to the right edge of 
the initially selected shape.  

 

Align Bottom 
Edges  

Aligns the bottom edge of all other selected shapes to the bottom 
edge of the initially selected shape.  

 

Align Top 
Edges  

Aligns the top edge of all other selected shapes to the top edge of 
the initially selected shape.  

 

Align Centers  Aligns the centers of all other selected shapes to the center of the 
initially selected shape.  

 

Align Centers 
Horizontally  

Aligns shapes horizontally in line with the center of the initially 
selected shape.  

 

Align Centers 
Vertically  

Aligns shapes vertically in line with the center of the initially selected 
shape.  

 

Note:  Use the Shift + selection mechanism to select the initial shape. 
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Make Same Size 

The Arrange | Make Same Size panel of ScanMaster Designer includes commands for making all 

shapes the same height or width. 

Icon  Name  Description  

 

Make Same 
Width  

Makes all shapes the same width.  

 

Make Same 
Height  

Makes all shapes the same height.  

 

Make Same Size  Makes all shapes the same width and height.  

 

Note:  The initially selected shape determines the size of the rest of the selected shapes. 

Horizontally Distribute 

The Arrange | Horizontally Distribute panel of ScanMaster Designer includes commands for 

distributing shapes from left to right. 

Icon  Name  Description  

 

Left Edges 
(Horizontally)  

Distributes the spaces proportionately between the left edges of the 
leftmost and rightmost shapes, in a horizontal order.  

 

Centers 
(Horizontally)  

Distributes the spaces proportionately between the centers of the 
leftmost and rightmost shapes, in a horizontal order.  

 

Right Edges 
(Horizontally)  

Distributes the spaces proportionately between the right edges of 
the leftmost and rightmost shapes, in a horizontal order.  

 

Note:  Distribute commands will be applied only for three or more objects.  

Vertically Distribute 

The Arrange | Vertically Distribute panel of ScanMaster Designer includes commands for distributing 

shapes from top to bottom. 

Icon  Name  Description  

 

Top Edges 
(Vertically)  

Distributes the spaces proportionately between the top edges of the 
topmost and bottommost shapes, in vertical order.  

 

Centers 
(Vertically)  

Distributes the spaces proportionately between the centers of the 
topmost and bottommost shapes, in vertical order.  

 

Bottom Edges 
(Vertically)  

Distributes the spaces proportionately between the bottom edges of 
the topmost and the bottommost shapes, in vertical order.  
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Spacing 

The Arrange | Spacing panel of ScanMaster Designer includes commands for distributing shapes 

evenly. 

Icon  Name  Description  

 

Horizontally 
Evenly  

Distributes the spaces proportionately between the leftmost and the 
rightmost shapes, in horizontal order.  

 

Vertically 
Evenly  

Distributes the spaces proportionately between the topmost and 
bottommost shapes, in vertical order.  

 Measure 

The Arrange | Measure panel of ScanMaster Designer includes the Linear commands for measuring 

the linear distance between two points on the canvas. 

Icon  Name  Description  

 

Linear  Measures the linear distance between two points on the canvas.  

 
 

 

 

 

 

 

 

 

 

 

 

 



The ScanMaster Designer Interface 

Version 3.2, Revision H 

4.4 THE DRAWING CANVAS AND THE SCRIPT WINDOW 

4.4.1 The Drawing Canvas 

ScanMaster Designer provides a two-dimensional Drawing Canvas for designing 2D images. Shapes 

placed on the canvas are defined relative to the coordinate system of the Drawing Canvas. Two rulers 

are provided that run horizontally across the bottom and vertically along the left side of the canvas. 

The X Axis and the  

Y Axis are indicated by two red lines that intersect at the center of the Drawing Canvas (Origin 0, 0). 

 

FIGURE 30: THE DRAWING CANVAS 
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Grid 

The Drawing Canvas can include a grid, as shown in the above figure. The grid is useful for aligning 

shapes and other graphics on the Drawing Canvas. To select a grid option, left-click the arrowhead 

next to the Grid  icon and select a grid option (Line, Dot, or Blank) from the drop-down menu. 

 

 

 

 

 

 

 

 

FIGURE 31: THE GRID  

¢ƻ ŜȄƛǘ {ŎŀƴaŀǎǘŜǊϰ 5ŜǎƛƎƴŜǊΣ ŎƭƛŎƪ ǘƘŜ Close button on the top right of the screen or select Exit 

from the {ŎŀƴaŀǎǘŜǊϰ 5ŜǎƛƎƴŜǊ button. 

 

Snap Tools 

The Snap tools just below the Drawing Canvas   make it easier to draw and modify 

shapes on the Drawing Canvas. They help you to pick an exact point on the Drawing Canvas or based 

on other Shapes. 

Icon  Command  Description  

 

Grid  Positions shapes to the closest intersection of the grid.  

 

Snap to Angle  Snap to a specified angle, relative to the last point in steps of 45 degrees.  

 

Snap to Objects  
Allows you to specify precise locations on objects. The following object 
snap methods are available: End Points , Mid Points , Center , Nodes , 
Tracking , Quadrants , Intersection , and Extension  

 

 

 

 

https://d.docs.live.net/548dfe7b0105be0e/Documents/CT%20Manuals/ScanMaster%20Designer%20User%20Manual.docx#_Ref365876909
https://d.docs.live.net/548dfe7b0105be0e/Documents/CT%20Manuals/ScanMaster%20Designer%20User%20Manual.docx#_Ref-1480733468
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4.4.2 Script Window 

The Script tab allows you to access the ScanMaster Designer ScanScript files of a project. It provides a 

means to communicate with external handlers and other controllers to automate a marking process. 

(See Chapter 11 for more information on ScanScript.) 

FIGURE 32: SCANMASTER SCANSCRIPT 

 

 

 

 

 

 

 

https://d.docs.live.net/548dfe7b0105be0e/Documents/CT%20Manuals/ScanMaster%20Designer%20User%20Manual.docx#How_to_script
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4.5 PROJECT EXPLORER 

A project can have several Images. Images created in the ScanMaster Designer are listed in a tree 

structure in the Project Explorer. The current Project is shown in the top level, with corresponding 

Images and the Script files below it. Right-click on an element in the Project Explorer to access its 

corresponding actions. 

To view the Project Explorer, click the Project Explorer tab. 

 

 

 

 

 

 

 

 

 

                                                                                                          

FIGURE 33: THE PROJECT EXPLORER 

Create a New 2D Image 

To create a new 2D Image, do one of the following: 

1. Left-click the 2D Image  command on 

the Project | Basic Elements panel of the 

Ribbon or 

2. In the Project Explorer, right-click on a 

Project name and select Create 2D Image 

from the context menu. 

A new 2D Image will be added to the Project. 

 

 

 

 

 

 

 

 

 

FIGURE 34: CREATING A 2D IMAGE IN THE PROJECT 

EXPLORER 
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Import an Existing 2D Image (Import Image File) 

To import a new 2D Image, do one of the following: 

¶ Left-click the Import icon  on the Project | Basic Elements panel of the Ribbon and 

select 2D Image from the context menu or 

¶ In the Project Explorer, right-click on a project name and select Import 2D Image from the 

context menu. 

The Open Vector Image File dialog box will be displayed. Browse and select the file that you want to 

import. 

Note:  ScanMaster allows you to import any of the following file types: svi, dxf, ai, pdf, drill files (nc, 

tp), or plt. 

The imported 2D Image will be added to the Project. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note:  If specific Laser Properties were set for a particular Image, those properties will be imported 

along with the Image.  
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Open an Image for editing 

To open an Image for editing, do one of 

the following: 

¶ Left-click on the tab for that 

Image on the right-hand side of 

the Drawing Canvas or 

¶ Left-click on the Image name in 

the Project Explorer. 

In this figure, the Image Tiling6_Cell0 is 

selected in both the Project Explorer 

and in the tab on the right-hand side of 

the Drawing Canvas. 

 

 

FIGURE 35: OPENING AN IMAGE FOR EDITING 

 

 

Delete an existing Image 

Do the following to delete an Image in the Project 

Explorer: 

1. Select the Image you want to delete.  

2. Left-click the Delete Image icon  or 

right-click on the Image and select Delete 

from the context menu. 

3. A confirmation message will be displayed. 

Click Yes to delete.  

The selected image will be removed from the 

project.  

 
  

FIGURE 36: DELETING AN EXISTING IMAGE 
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Rename an Image 

Do the following to rename an image in the Project Explorer: 

1. Right click on the image name in the Project Explorer. 

2. From the right click menu, select the Rename option. This displays the Enter New Name 

dialog box. 

3. Type the new name in the Enter New Name dialog box, and press the OK button. 

 

 

 

 

 

 

 

 

 

 

FIGURE 

37: 
RENAMING AN IMAGE 
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Export an Image 

Do the following to export an Image in the 

Project Explorer: 

1. Select the Image in the Project Explorer 

and  

left-click the Export icon  on the 

Home | Standard panel of the Ribbon or 

2. In the Project Explorer, right-click on a 

Project name and select Export from the 

context menu. 

3. The Save As dialog box will be displayed. 

Browse to the desired location, enter a 

name for the file, and click the Save 

button. 

The files will be saved in .svi format. 

  

FIGURE 38: EXPORTING AN IMAGE 

Reorder Images 

Do the following to reorder Images in the Project Explorer: 
1. Select the Image to be reordered on the Project Explorer. 

2. Use the Move Up arrow  or the Move Down arrow  to reorder the Image as required. 

 

 

 

 

 

 

 

FIGURE 39: USING THE "MOVE UP" AND "MOVE DOWN" ARROWS IN THE PROJECT EXPLORE 
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4.6 SHAPE TREE 

ScanMaster Designer uses Layers for organizing and structuring drawing Shapes in an Image. In the 

Shape Tree, the Shapes are listed in the order in which they will be marked. A Shape can be selected 

by clicking on the corresponding element in the Shape Tree. Multiple shapes may be selected by 

Shift-clicking on a range of shapes, or Control-clicking to select multiple individual shapes. 

 

 

 

 

 

 

 

 

 

FIGURE 40: THE SHAPE TREE 

4.6.1 Layers 

When a Shape is selected, it will be highlighted in the Shapes Tree and on the Drawing Canvas. 

Shapes are scanned in the order in which they are listed in the Shape Tree. To change the order, click 

on the Shape and drag it to a new position in the Shape Tree. The new position can be in the same 

Layer or in a different Layer. 

Add a Layer 

To create a new Layer, click the Add Layer  button in the Shape Tree.  

Remove a Layer  

Do the following to remove a Layer: 

1. Select a Layer from the Shape Tree. 

2. Click Remove Layer . 
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3. A confirmation message will be displayed. Click Yes to remove the Layer. 

Rename a Layer 

Renaming a Layer allows you to give the Layer a name that reflects its contents. This helps users to 

easily identify Layers in the panel. 

Do the following to rename a Layer: 

1. Right click the Layer name and select Rename. 

2. Type the new name and OK. 

Changing Layer Properties 

Layer properties can be changed by clicking the Layer Properties  button on the Shape Tree 

window. The Layer Properties window will be displayed. All the Layers associated with the Image are 

listed on the left side of the Layer Properties window. 

 

 

 

 

 

 

 

FIGURE 41: THE LAYER PROPERTIES WINDOW 
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Property  Description  

Layer Name  
This field displays the name of the Layer. You can change the Layer name by 
entering a new one in this field.  

Hidden  

If  Hidden is selected, then the particular Layer or object will not be visible on 
the Drawing Canvas. If the Layer or object is hidden, its eye drop will have a 
red "X" on it, as in the following example:  

 

Locked  

If Locked  is selected, then the objects on the Layers cannot be moved from 
their positions.  

Note:   Even when Locked  is selected, other operations (e.g., Mirroring, 

Snapping) can be done without any restrictions.  

Not Selectable  
If Not Selectable  is selected, then the Shapes in the particular Layer cannot be 
selected from the Drawing Canvas. None of the Shapes operations (except 
Snapping) can be performed on these Shapes.  

 

The Hidden property can be selected from the Layer Properties window or from the Shape Tree. 

¶ To select the Hidden property from the Laser Properties window, select the Hidden check 

box. This applies the Hidden property to all of the objects that the Layer contains. 

¶ To select the Hidden property from the Shape Tree, left-click the eye drop icon in front of a 

Layer or object. With this method, the Hidden property can be applied to an entire Layer or 

to individual objects that the Layer contains. 

4.6.2 To Enable or Disable Marking 

Click on the tick in front of a Layer name or object name to enable or disable marking. If you click the 

tick in front of a Layer name, marking will be enabled or disabled for the entire Layer. If you click the 

tick in front of an object, marking will be enabled or disabled for the individual object. 
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4.7 PROPERTIES WINDOW 

The properties window contains two tabs: Properties and Laser Properties. The Properties tab 

displays geometrical properties of the currently selected Shape. The Laser Properties tab displays the 

general properties and delay properties of the currently selected Shape. 

4.7.1 Shape Properties 

The Properties tab enables viewing and editing properties of the selected Shape. Changes to these 

values take effect immediately. If Shape properties are changed, the Shape is immediately redrawn 

on the canvas. 

You can display or hide the properties panel by using the Auto-Hide  toggle in the upper-right 

corner of the Properties tab ς the Properties tab and the Laser Properties tab will be minimized to 

the right side of the SMD window. 

! ǎŀƳǇƭŜ ƛƭƭǳǎǘǊŀǘƛƻƴ ƻŦ ŀ ǎŜƭŜŎǘŜŘ {ƘŀǇŜΩǎ ǇǊƻǇŜǊǘƛŜǎ ƛǎ ǎƘƻǿƴ ōŜƭƻǿΥ 

 

 

 

 

 

 

 

 

 

 

 

 

 

FIGURE 42: SHAPE PROPERTIES 
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4.7.2 Laser Properties 

Depending on the marking job, and the required marking quality, you may have to specify different 

laser parameters. The Laser Properties tab allows you to view and edit laser properties for a 

particular marking job. The two laser property types are General and Quality. 

The properties in the Laser Properties tab will change according to the Modulation View Option and 

the Laser Type. The former is set on the General tab of the Application Preferences window, and the 

latter is set on the Laser tab of the Application Preferences window. Refer to "Laser Options Tab 

Laser Type" on page 87 for more information on these settings. 

Note:  If Use Parent Settings is selected, the laser properties of the Shape cannot be edited in the 

Laser Properties tab; all of the Shape's laser properties will be inherited from the Layer. 

Laser Properties ς General Tab 

The Laser Properties tab of ScanMaster Designer describes the laser parameters which will be 

applied during the laser marking processes. 

The Profile menu in the Laser Properties window allows you to load predefined settings or save 

current settings for later retrieval, and the Use Variable option allows you to enable accessing of the 

profile within the main ScanScript script.  This permits run-time modification of each of the laser 

properties. 

 

 

 

 

 

 

 

 

 

FIGURE 43: LASER PROPERTIES ς GENERAL 
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Laser 
Pro perty  

Description  

Mark 
Speed  

Sets the speed during marking.  

Jump 
Speed  

Sets the speed during jumping.  

Note:  A jump causes a (typically) rapid movement of the scanner mirrors to a new 
position. No marking occurs during a jump.  

Power  Sets the laser power as a percentage.  

Modulatio
n 
Frequenc
y  

Sets the laser modulation frequency in kHz.  

Duty cycle 
for 
Channel 1 
/Pulse 
Width for 
Channel 1  

Sets duty cycle or the pulse width for channel 1 as a percentage. The modulation can be 
displayed as Frequency and Duty C ycle or as Pulse Period and Pulse Width. Refer to 
"Error! Reference source not found. " on page Error! Bookmark not defined.  for 
more information on how to display the modulation. You can select the Channel from the 

Preferences window.  

Pulse 
Period  

Elapsed time from the beginning of one pulse to the beginning of the next pulse  

Wobble 
Thickness  

Sets the wobble thickness.  

 

Wobble 
Overlap  

Sets the wobble overlap.  The overlap distance is 100 minus the Wobble Overlap value 
as a percentage of the thickness.  

Repeat 
Count  

Sets the number of times that an object will be marked. Repeat count of the shapes are  
handled individually.  
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4.8 LASER PROPERTIES - QUALITY TAB 

 

FIGURE 44: THE LASER PROPERTIES QUALITY TAB 
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Mark Delay 

A delay at the end of marking a line segment allows the mirrors to move to the required position, 

prior to executing the next mark command. Too short of a Mark Delay will allow the subsequent 

jump command to begin before the system mirrors get to their final marking position; the end of the 

current mark will turn towards the direction of the jump vector, as shown in the following figure. Too 

long of a Mark Delay will cause no visible marking errors but will add to the overall processing time. 

 

 

 

 

FIGURE 45: TOO SHORT OF A MARK DELAY 

Jump Delay 

During a jump, the system mirrors accelerate rapidly to get to the next marking positionτideally at 

the fastest speed possibleτto minimize the overall marking time. As with all accelerations, mirror 

inertia and system inertia create a slight lag at the beginning of the acceleration. Likewise, the 

system will require a certain delay (settling time) at the end of the jump, as it decelerates to precisely 

the correct location required for accurate marking. 

Too short of a Jump Delay will cause marking to start before mirrors are properly settled, resulting in 

inadvertent marking. Too long of a Jump Delay will have no visible effect, but marking is delayed, so 

overall job production time (marking time) increases. 

 

 

 

 

 

FIGURE 46: TOO SHORT OF A JUMP DELAY 
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Poly Delay 

A Poly Delay (polygon delay) is a delay automatically inserted between two consecutive marking 

ǎŜƎƳŜƴǘǎΦ ¢ƘŜ ŘŜƭŀȅ ŀƭƭƻǿǎ ŜƴƻǳƎƘ ǘƛƳŜ ŦƻǊ ǘƘŜ ƎŀƭǾƻǎ ŀƴŘ ƳƛǊǊƻǊ ǘƻ άŎŀǘŎƘ-ǳǇέ ǿƛǘƘ ǘƘŜ ŎƻƳƳŀƴŘ 

signal, before a new command is issued to move on to the next point. If variable polygon delay 

mode is selected, then the delay is variable and changes as a function of how large an angular change 

is required, to move on to the next point. The larger the angular change, the longer it takes for the 

galvos to change direction and accelerate to the required speed in the new direction. The delay is 

scaled proportionally to the size of the angle. 

FIGURE 47: ISSUES WITH POLYGON DELAYS 

 

If the variable polygon delay feature is selected in the laser preferences, then the polygon delay 

value will be scaled as a function of the angular change at the vertex according to the following 

diagram. 

 

 

 

 

 

 

 

FIGURE 48: VARIABLE POLYGON DELAY SCALING 

Laser On Delay 

The Laser On Delay can be used to prevent burn-in effects at the start of a vector. This delay is 

typically used to turn on the laser, after the first few micro steps of a mark command, to ensure that 

https://d.docs.live.net/548dfe7b0105be0e/Documents/CT%20Manuals/ScanMaster%20Designer%20User%20Manual.docx#_Enable_variable_polygon
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ǘƘŜ ƭŀǎŜǊΩǎ Ƴƻǘƛƻƴ ŎƻƴǘǊƻƭ ǎȅǎǘŜƳǎ όƳƛǊǊƻǊǎΣ ŜǘŎΦύ ŀǊŜ άǳǇ ǘƻ ǎǇŜŜŘέ ōŜŦƻre marking. The vectors must 

be scanned with a constant velocity to ensure uniform marking. This delay can have either a positive 

or negative value and will vary with different marking media (some media require a burn-in time to 

begin marking). The goal is to adjust Laser On Delay to ensure uniform marking with no variations of 

intensity throughout the desired vector. Too short of a delay will typically cause burn-in effects, and 

too long of a delay, will typically cause skipping (missed line segments). 

 

FIGURE 49: ISSUES WITH LASER ON DELAYS 

 

Laser Off Delay 

The Laser Off Delay can be used to prevent burn-in effects at the end of a vector. This delay is 

typically used to turn off the laser just before the last few micro steps of a mark command, to ensure 

that the marking stops exactly where it is supposed to stop. The goal is to adjust the Laser Off Delay 

to ensure uniform marking with no variations of intensity throughout the desired vector. Too short of 

a delay will typically cause skipping of line segments, and too long of a delay will typically cause burn-

in at the end of line segments. 
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Laser Pipeline Delay 

The Laser Pipeline Delay shifts all of the laser timing signals relative to the generation of the position 

commands. This shifting compensates for the finite amount of time it takes for the servos to process 

the command information. By using this compensation, it is possible to have a Laser On Delay value 

of zero, since all of the laser timing signals are shifted to synchronize the time the laser actually starts 

emitting with the time the galvos actually start. 

The advantage of being able to set Laser On Delay to zero is thatτeven if mark vectors are very 

shortτthe laser will always be guaranteed to turn on. Otherwise, if the vectors are so short that they 

complete in a time less than the Laser On Delay, the laser will not turn on and faulty marking will 

result. Because the laser may not turn off at the same rate that it turns on, Laser Off Delay is used to 

synchronize the laser and galvo timing at the end of a move. This adjustment should be done after 

the start of mark-vector/laser timing is synchronized using Laser Pipeline Delay. Normally, the galvos 

respond slower than the laser, so the resulting Laser Pipeline Delay will almost always be greater 

than zero. If, however, the laser has a very slow turn-on, it may be necessary to turn the laser on 

before the galvo commands are issued. This is done by setting the Laser On Delay to a negative value 

and the Laser Pipeline Delay to zero. 

Velocity Compensation 

Velocity Compensation allows users to change the average laser power property in real-time, based 

on the simulated velocity of the scanners. The Velocity Compensation settings are useful because 

the velocity of the spot slows down as the galvos trace out an arc or sharp corner. (This slowdown is 

due to the inability of the galvos to instantaneously change speed or direction.) Too low a marking 

speed may nonetheless result in an excessive mark depth or burning, particularly in the corners 

where only partial penetration may be desired. Average laser power "at the work surface" can be 

controlled in one of three ways (DutyCycle, Power, or Frequency), depending on the type of laser 

being used.  

The Velocity Compensation settings are the following: 

¶ Mode ς Sets the mode of operation; Disabled, Duty cycle (pulse width changes), Frequency 

(pulse period changes) & Power (analog or digital power changes). 

¶ Limit ς Sets the limit of maximum compensation as a percentage of the normal marking 

power level. Its range is 0 (maximum compensation) to 100% (no compensation). 

¶ Aggressiveness ς Sets how aggressively the system will compensate for velocity changes.  

The higher the number, the quicker the change will be applied. This number directly 

correlates to the tuning bandwidth of the galvo servos. 
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Accuracy 

The Accuracy settings are the following: 

¶ Break Angle ς The angle between contiguous vectors below which Max Radial Error is 
ignored and servo dynamics smooth the transition. Often useful for vectorized fonts, where 
curves are approximated by polylines with small angle changes. 

¶ Max Radial Error ς The allowable deviation from commanded trajectory, above which 
ά{ƪȅǿǊƛǘƛƴƎέ ƛǎ ŀŎǘƛǾŀǘŜd. 
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4.8.1 Profiles 

A profile consists of laser settings specified in 

the Laser Properties section. The laser settings 

will differ depending on the marking material 

and process. By saving these settings as a 

profile, you can avoid repeating the process for 

a Shape that uses the same parameters. The 

following options are available in the Profile 

menu: Quick Load, Material Library, Save, 

Copy, and Paste. 

The Profile menu is available on the Laser 

Properties window.  Left-click the Profile menu 

to see its options. 

  

FIGURE 50: PROFILE OPTIONS 

Working with Profiles in the Material Library 

The Material Library contains 

profiles for marking options. This 

section describes how to manage 

profiles in the Material Library. 

To display the Material Library, 

select the Material Library option 

from the Profile menu. 

 

 

FIGURE 51: SELECTING THE MATERIAL LIBRARY OPTION FROM THE 

PROFILE MENU 
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The Material Library window is displayed as shown in the following figure. 

 

FIGURE 52: THE MATERIAL LIBRARY WINDOW 

Load a Profile 

Saved profiles can be retrieved from the Material Library.   

Do the following to load a profile: 

1. Select the shape for which you wish to apply the profile. 

2. From the Profile list in the Properties tab, select Quick Load. The saved profile will appear in 

the relevant folder structure. 
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FIGURE 53: LOAD PROFILE 

Add new folders 

You can add new folders under Material Library. To add a new folder, right-click on the Items list in 

the Material Library window and select New Folder. 

 

Rename a Profile 

You can rename profiles listed under the Material Library. 

Right-click on the profile name you wish to rename and select Rename. Type the new name and 

press the OK button. 

 

Delete a Profile 

Select the profile you want to delete, right-click on it and select Delete. 
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Add a new Profile to the Material Library 

! {ƘŀǇŜΩǎ ƭŀǎŜǊ ǇǊƻǇŜǊǘƛŜǎ Ŏŀƴ ōŜ ŀŘŘŜŘ ǘƻ ǘƘŜ Material Library for later retrieval. 

Do the following to add and save a profile: 

1. Click Profile | Save in the Laser Properties section. The Save Marking Profile window will be 

displayed. 

2. Select the type of Laser from the Laser list. 

3. In the Material list, select a material type. If materials are not available click the Edit button 

to add new materials or edit the existing ones. 

4. Select a process from the Process list. 

5. If you wish to apply a color for the selected Shape, click the color selection button and select 

the desired color from the color palette. 

6. In ScanMaster Designer the saved profile can include a specific Logo/Image for identification.  

Click Load Image, locate the Image you wish to load from the Open dialog box, and click 

Open. 

7. The current settings will be displayed under the General and Quality tabs. You can change 

these settings if necessary. 

8. Specify a brief description of the profile in the Description box.  

9. Finally click Save. The following window will be displayed. 

 

 

 

 

 

 

 

 

                                                                                 

FIGURE 54: SAVE PROFILE DIALOG 

10. Select a folder and give an appropriate name for the profile. 
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11. Click Save.  

 

FIGURE 

55: 
SAVE 

MARKING PROFILE 

Searching for a Profile 

You can search for a particular Laser profile using the in-built filters of the Material Library. To search 

for a Laser profile: 

1. Click Profile | Material Library on the Laser Properties panel. This will load the Material 

Library window. 

2. Use the Laser, Material, Process and Description Contains fields to sort the list of Laser 

profiles. 

3. If a match (or matches) have been found based on the specified criteria, these would be 

displayed in the Laser profiles list. 

4. Select the Laser profile, perform any edits as required, and click OK to load the Laser profile. 
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FIGURE 56: MATERIAL LIBRARY 

 

Copy and paste Profiles 

You can copy a Laser profile and apply it to a different Shape. 

5. Load the Laser profile or select the Shape that contains the profile you wish to copy. 

6. From the Profile list, select Copy. 

7. Select the Shape to paste the copied profile to. 

8. From Profile list, select Paste. The Laser properties of the selected shape will update 

accordingly. 
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Laser Variables 

You can load saved Laser properties from the Use Variable option on the Laser Properties tab. Any 

laser variable you saved or created will be accessible from this menu. 

  

FIGURE 57: THE USE VARIABLE CHECKBOX 

 

To load a Laser variable from this menu, first deselect Use Parent Settings and click on the Use 

variable check box. If you have saved any variables previously, they will be listed in the menu and the 

following screen will be displayed. 

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

FIGURE 58: LASER VARIABLES 

You can change the General and Quality settings and assign a color for the variable. Once you make 

the necessary changes, click OK. You can also add, delete, and rename new laser settings files.  
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4.9 CONNECTING TO DEVICES 

The Devices section is located to the right of the ScanMaster Designer window.  All available scan 

controllers will be listed in this window. Note that ScanMaster Designer may have already connected 

to the specified Scan Controller automatically. See Device Auto Connect. 

4.9.1 Connect to a particular card 

Do the following to connect a device to a particular 

Scan Controller: 

1. Go to the Devices tab. All of the connected 

Scan Controllers will be listed. 

2. Select the Scan Controller. 

3. Click the Connect  icon. 

 

FIGURE 

59: DEVICES 

ς NOT 

CONNECTED TO A CARD 

Note:  When the user is connected to a particular Scan Controller, the Connect button will become 

disabled and the Laser Marking buttons will be enabled. In the above example, the user is connected 

ǘƻ ǘƘŜ  ŎŀǊŘ ǿƘƛƭŜ ǘƘŜ ά{a/ нέ ŎŀǊŘ ƛǎ ƛƴŘƛŎŀǘŜŘ ŀǎ ōǳǎȅΦ 

4.9.2 Disconnect a Scan Controller 

Do the following to disconnect a Scan Controller: 

1. Select the Scan Controller you wish to 

disconnect. 

2. Click the Disconnect  icon. 

 

FIGURE 60: DEVICES ς CONNECTED TO A CARD 

https://d.docs.live.net/548dfe7b0105be0e/Documents/CT%20Manuals/ScanMaster%20Designer%20User%20Manual.docx#_Devices
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4.10 OUTPUT WINDOW 

The Output window is used to display ScanScript Report messages, error messages, and the stack 

trace of the errors generated by a ScanScript program. 

Report messages can be used to provide any useful information generated within the script to the 

user. 

A stack trace can be used to determine where an error occurred. It displays a stack trace from its 

invocation point. It includes the source script file name, function name and program line number. 

This feature is especially useful when the function that generated the error is nested within other 

functions. Furthermore, when several script files are in use and if the same function is being used by 

several scripts the stack will tell you where to go if there was an exception. 

 

 

FIGURE 61: SCANSCRIPT OUTPUT WINDOW INTERFACE CUSTOMIZATION 
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4.10.1 Arranging windows and panels on the screen 

To maximize your ScanMaster Designer screen real 

estate, use the Auto-Hide toggle button which can 

either show or hide the particular window panel. This 

button is available on all of the display panels.   

When Auto-Hide is turned on, the panel will remain 

hidden until you move the mouse pointer over it. The 

hidden panel will be displayed until you move the mouse 

pointer away. 

 

FIGURE 62: HIDDEN PANELS 

 

 

Move panels in the ScanMaster Designer window 

Do the following to move a particular panel from its default position: 

1. Click on the tab header or a blank portion of the relevant ǇŀƴŜƭΩǎ ǘƛǘƭŜ ōŀǊΦ 

2. Hold down the left mouse button, and drag the mouse pointer to the place on the screen 

where you want the panel. 

A guide diamond appears. The four arrows of the diamond point toward the four sides of the 

screen. Four other arrows point to the four edges of the screen. 

3. Move the mouse pointer to the position on your screen where you want the panel, then 

move the pointer over the corresponding portion of the guide diamond. The designated area 

is shaded. 

4. To dock the window in the position indicated, release the mouse button. 

 

Hidden 
Panels 
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FIGURE 63: MOVING THE PANEL 

 

 

 

 

 

 

 

 

 

 

 

 

FIGURE 64: THE PANEL AFTER MOVING 
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4.11 ROLE-BASED ACCESS CONTROL 

ScanMaster Designer allows you to restrict access to functionalities by managing user permissions.  

In Role-based Access Control, roles are created for various jobs and permission to perform certain 

operations is then assigned to roles. 

The Users and Groups option in the Preferences window allows you to manage users and their roles. 

 

FIGURE 65: PREFERENCES ς USERS AND GROUPS TAB 

 

Note:  Only users with administrative privileges will have access to the Users and Groups tab in the 

Preferences window. If the account by which you are currently logged-in does not have 

administrative privileges, you will be required to enter an administrative account login, as shown in 

the following window. 
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FIGURE 66: PREFERENCES - USERS AND GROUPS LOGIN SCREEN 

 

4.11.1 Users 

Users take on assigned roles such as Administrator, Operator, or Engineer. Apart from these default 

users, you can add as many users as required. A user can have multiple roles. 
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Add new users 

Do the following to add a new user to the system: 

1. Click Add in the Users tab in the Users and Groups page in Preferences. 

 

 

 

 

 

 

 

 

 

 

FIGURE 67: ADD NEW USER 

2. Enter the User Name and Password for the new user. 

3. Assign the necessary roles. A user can have more than one role. Permissions for the selected 

role will be displayed in the Permissions pane. Permissions will be assigned at the time of 

creating Roles. 

4. Click OK. 

 

Remove users 

Do the following to remove an existing user: 

1. Select the relevant user. 

2. Click Remove. 
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4.11.2 Add a new role 

A role defines the tasks that an end user sees in ScanMaster Designer. Permissions are assigned to 

roles. Follow the given steps to add a new role: 

1. Navigate to Preferences | Users and Groups and click Add from the Roles tab. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

FIGURE 68: ADD NEW ROLE 

 

2. Enter a name for the new role in the Role Name field. 

3. You can copy permissions assigned to the existing roles. Once you copy the permissions you 

can manually edit them by selecting or deselecting the options. If you have a role that 

contains the permissions you want to grant to users, but you want to remove or add one or 

two permissions without having to add all the other permissions manually, you can copy the 

existing role. 

4. Select the type of role by checking the relevant checkboxes from the Role assigned users list 

of checkboxes. 

5. Make the necessary modifications to the permissions using the Permissions list of 

checkboxes. 

6. Click OK to save changes. 
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4.11.3 Enable Login 

To enable the Login screen click Enable Login. Next time when you start ScanMaster Designer you 

will be prompted with a login screen: 

 

 

FIGURE 69: LOGIN DIALOG 

 

1. Note:  The Username and Password fields are case-sensitive in the ScanMaster Designer 

login screen. 

2. If you click the Remember Me checkbox, you will not be prompted to login again on the 

same computer, unless you intentionally logout of ScanMaster Designer (using the Logout 

option). 

3. Once logged in the user name will be displayed next to the Help button in the upper-right 

corner of the screen. 

4. Clicking on the arrow next to the user name will give access to the Log out and Change 

Password options; you can log out any time by clicking on the Log out option. 

5. Note:  Once intentionally logged out, stored credentials (if the Remember Me options was 

selected), will be lost and you will be required to enter your login credentials once again to 

log in to ScanMaster Designer. 
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Change Password 

The account password could be changed by clicking the drop down arrow beside the currently logged 

in as notification. Fill out the fields below to change the password. 

 

FIGURE 70: CHANGE PASSWORD DIALOG 

 

Type your old password, type your new password, type your new password again to confirm it, and 

then press OK. 

4.11.4 Export/Import Login Data 

The following options can be used to transfer login credentials of a userbase, along with their role 

permissions, to an offsite location: 

¶ Export Login Data ς specifies that login data will be exported as a Login data file.  You can 

export the username, password and permissions. 

¶ Import Login Data ς specifies that login data will be imported as a Login data file.  You can 

import the username, password and permissions. 

 

4.11.5 User Logging 

ScanMaster Designer contains an in-built user logging mechanism, where the logout and login times 

of each user is tracked. This login session information is saved in the installation directory of 

ScanMaster Designer, within the UserLogger.txt file. 
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4.11.6 User Files 

The User Files option in Preferences allows you to define the list of files that each user is permitted 

ǘƻ ŀŎŎŜǎǎΦ LŦ ǘƘŜ Ψ/ŀƴ ƻƴƭȅ ƻǇŜƴ ŦƛƭŜǎ ǘƘŀǘ ƛǎ ƛƴ ǘƘŜ Ƨƻō ƭƛǎǘΩ option in Permissions is selected the 

relevant user can only access the files defined in this job list. You can add any amount of .sdw files to 

this list. 

 

 

FIGURE 71: PREFERENCES - USER FILES 

 

Select the User Name and click the Add File   button to add the files to the list. To remove a file 

from the list, first select it and click the Delete File   button. (See Preferences for more 

information.) 

 

 

 

 

https://d.docs.live.net/548dfe7b0105be0e/Documents/CT%20Manuals/ScanMaster%20Designer%20User%20Manual.docx#_Preferences
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5 MANAGING PROJECTS 

5.1 BEFORE YOU CREATE A NEW PROJECT 

Before you create a new Project, do the following: 

1. Get familiar with the project structure, the program default settings, and the supported 

drawing file formats. The following section ("Preferences vs. Settings") provides detailed 

information regarding application and project settings. 

2. Make sure the correct unit of measurement is set. 

3. Use Rulers and set the relevant grid lines for accurate positioning and alignment of elements 

on the Drawing Canvas. 

4. If you do not already have a basic understanding of the software interface, see Chapter 4: 

ScanMaster Designer Interface. 

5. Create a project hierarchy; before you begin a project determine the order of execution and 

create Images accordingly.  

6. Make sure to embed the required text fonts, as the Scan Controller does not contain any text 

fonts of its own. 

Save documents frequently, and create backup copies of important files. 

Note:  All ScanMaster Designer drawings will be saved in .sdw format. However, you can export 

drawings as .svi files and the scripts as .lsc files. 

5.2 PREFERENCES VS. SETTINGS 

Preferences are the project default settings to be used for any new project you create in ScanMaster 

Designer. They are displayed in the Application Preferences window, which is shown in Figure 75 on 

page 78. 
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Project Settings relate to the settings of the currently active project. They are organized in General, 

Laser, Transform, Text embeds, Scripting and Marking Area tabs.  

You can change the settings of the current project you are working on by clicking Project Settings   in 

the Project Explorer window. 
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5.3 THE APPLICATION PREFERENCES WINDOW 

To display the Application Preferences window, left-click the File tab to display the File menu, and 

then left-click the Preferences button  in the lower-right corner of the File menu. 

5.3.1 General 

The following figure shows the General tab in the Application Preferences window. 

Note:  The General tab is displayed when you left-click the Preferences button  to 

display the Application Preferences window. 

 

 

 

 

 

 

 

 

 

 

 

FIGURE 75: PREFERENCES ς GENERAL TAB 

 

Default Units 

The Default Units setting is used to measure positions, distances, and speeds. There two options for 

Default Units are Millimeters and Inches. 

Language 

The Language setting is used to change the application language. Select the required language using 

the dropdown list and restart the application for changes to take effect. 
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Output Window 

The Output Window settings allow you to change the font and the font size of the Output Window. 

Script Assistant 

The Script Assistant Port is used to access external files or databases for advanced marking 

applications (e.g., tray marking by means of input from a remote location). 

Number Format 

The Number of digits after decimal specifies the number of decimal places to see when numbers are 

shown in the text boxes. 

External Tools 

Left-click the External Tools button to display the External Tools dialog box. The External Tools 

dialog box is used to add items for launching external tools to the Ribbon. 

 

 

 

 

 

 

 

 

 

 

FIGURE 72: THE EXTERNAL TOOLS DIALOG BOX 
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Adding an External Tool 

Do the following to add an External Tool from the External Tools dialog box: 

1. Click the Add button and enter the name for the tool in the Title field. 

2. In the Command field, enter the path of the tool to be added, or click Browse  icon to 

navigate and select the tool to be added. 

3. In the Arguments field, you can specify the information that is to be passed to a command 

when it is launched. 

4. In the Working Dir field, you can specify the working directory for the tool. 

5. Select one or both of the following check boxes to specify where the external tool button will 

be displayed: 

6. Show in Main ToolBar ςDisplays the external tool button in the Ribbon. 

7. Show in Device Menu ςDisplays the external tool button in the device menu that appears 

when you right-click on a connected Scan Controller. 

8. Click OK to commit the changes. 

 

Removing an External Tool 

Do the following to remove an External Tool from the External Tools dialog box: 

1. Highlight the tool that you want to remove in the Tools list. 

2. Click the Remove button. 

Tool ordering 

Do the following to position tools in a specific order: 

1. Select the tool to be repositioned by clicking on the relevant title. 

2. Rearrange the titles as required, using the Up/Down commands. 

3. Click OK to commit changes. 

 

 

 



Managing Projects 

Version 3.2, Revision H 

Resetting the Docking GUI Layout and Quick Access Bar 

To return the Docking GUI layout, and the Quick Access Bar, to their default locations, left-click the 

Reset Layout button  on the General tab of the Application Preferences window.  

Note:  The Reset Layout button can also be used to bring all elements back into the GUI in the event 

you cannot see any of the display panel.  

When you left-click the Reset Layout button, the following dialog box is displayed. 

 

 

 

 

 

 

 

FIGURE 73: APPLICATION RESTART PROMPT 

 

Click the Yes button to reset the GUI layout and restart the application. 

Click the No button to cancel the reset and return to the General tab of the Application Preferences 

window. 
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The following figure shows how the GUI will look after the Docking GUI Layout and Quick Access Bar 

are reset with the Reset Layout button. Note that all of the GUI windows are at their default 

locations and there are no icons in the Quick Access Bar. 

 

FIGURE 74: THE SCANMASTER DESIGNER GUI AFTER RESET LAYOUT 

 

Large Image View Option 

 The General tab of the Application Preferences window contains the Large Image View Option 

setting, which specifies whether large vector images (e.g., logos) will be hidden or shown. Select Hide 

Content of Large Vector Image to hide large vector images. Deselect it to show large vector images. 

Note:  Users typically opt to hide large vector images if they find it difficult to work with them on the 

Drawing Canvas. 
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5.3.2 Keyboard Shortcuts 

The following figure shows the Keyboard Shortcuts tab of the Application Preferences window. You 

can use the Keyboard Shortcuts tab to assign keyboard shortcuts to frequently used commands. 

 

FIGURE 75: THE KEYBOARD SHORTCUTS TAB OF THE APPLICATION PREFERENCES WINDOW 

 
Do the following to configure a keyboard shortcut for a particular command: 

1. Select the command by scrolling though the list of commands, or enter a filter to search for a 

particular command using the Show Command Containing field. 

2. Put the cursor in the Shortcut for Selected Command field and press the combination of keys 

you wish to specify for that command. If the key combination you specify is currently bound 

to another command, this will be indicated in the Shortcut currently used by field. 

3. Click the OK button to commit your changes. 
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5.3.3 Saving 

The following figure shows the Saving tab of the Application Preferences window. You can use the 

Saving tab to specify the Auto Recovery frequency and whether saved scanning jobs will be 

accessible through the ScanMaster Application Programming Interface (SMAPI). 

 

FIGURE 76: THE SAVING TAB OF THE APPLICATION PREFERENCES WINDOW 

 

Auto Recovery  

The Auto Recovery feature ensures that ScanMaster Designer periodically saves your current project. 

You can specify the frequency (in minutes) by which the project is saved by entering a value in the 

text entry field. 

Embed Scanning Information 

When this option is selected, the saved scanning jobs (.sdw files) will contain an SMAPI format. 

Subsequently these .sdw files will be accessible through the SMAPI. 
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5.3.4 Application Folders 

The following figure shows the Application Folders tab of the Application Preferences window. You 

can use the Application Folders tab to change the saving paths of the Material Library, Laser 

Information, Pre/Post Script Configuration, Auto Saved Files, and Logs. 

When you change the location of any of these paths, make sure that every ScanMaster Designer user 

who needs access to the path has read and write access to it. 

 

FIGURE 77: THE APPLICATION FOLDERS TAB OF THE APPLICATION PREFERENCES WINDOW 

 

To change a path, type a new path in the text entry field or click the Browse button to browse to an 

existing path. 

Click the Reset button to reset a path to its default value. 
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Users and Groups 

The following figure shows the login screen for the Users and Groups tab of the Application 

Preferences window. This login screen is the first screen displayed when the Users and Groups tab is 

selected. You must log in as an administrator to use any of the features of the Users and Groups tab. 

 

FIGURE 78: PREFERENCES - USERS AND GROUPS LOGIN SCREEN 

For more information on the Users and Groups tab, refer to "Role-based Access Control" on page 70. 
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5.3.5 Laser 

The following figure shows the Laser tab of the Application Preferences window. You can use the 

Laser Options tab to specify a Laser Type and its beam width and image streaming. You can use the 

Align/Trace Options to specify Align/Trace Options, including dry run speed, count, and general laser 

parameters specifically for Align and trace operation. 

 

FIGURE 79: THE LASER TAB OF THE APPLICATION PREFERENCES WINDOW: LASER OPTIONS 

Laser Options Tab 

Laser Type 

The Laser Type dropdown allows you to select the appropriate laser type to be used. Clicking on the 

Edit button will display the Laser Settings Editor. You can use the Laser Settings Editor to add and 

delete laser types as well as specify Default Laser Properties and other settings for a laser type.  

Refer to page Error! Bookmark not defined. for more information about the Laser Settings Editor. 

Beam width 

The Beam width field is used to set the width of the laser beam. 
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Marking Quality Maximum Error 

The Marking quality maximum error setting is the maximum error allowed when marking curves. 

Enable image streaming by default 

Select Enable image streaming by default to specify streaming mode as the default scanning mode 

for Images. Streaming is required when scanning a large Image which cannot be fully downloaded to 

the device due to its limited memory.  

 

Align/Trace Options Tab 

 

FIGURE 80: THE LASER TAB OF THE APPLICATION PREFERENCES WINDOW: ALIGN/TRACE OPTIONS 
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Speed/Counts Settings 

Dry run speed 

The Dry run speed setting is the speed that will be used to execute a dry run of an align or trace 

operation.  This is the speed of the galvos when the laser would normally be on. 

Dry jump speed 

The Dry jump speed setting is the speed that will be used to execute the jumps during a dry run of an 

align or trace operation. 

Count 

The Count setting is the number of times that an align or trace operation will be repeated. 

 

Delay settings 

The delay settings permit more accurate rendering of the traced shape using the laser pointer. 

Mark Delay 

The delay inserted after each simulated mark. 

Jump Delay 

The delay inserted after each jump. 

Laser On Delay 

The delay inserted before turning on the pointer at the beginning of a simulated mark. 

Laser Off Delay 

The delay inserted before turning the pointer off at the end of a series of connected simulated 

marks. 

Poly Delay 

The delay inserted at each vertex. 

Pipeline Delay 

An additive delay to the Laser On/Off delays 

Exclude Scripts 

If checked, do not execute job pre-/post-scripts when performing the tracing/aligning funcitons. 
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5.3.6 Laser Settings Editor 

The Laser Settings Editor is used to add and delete laser types as well as specify Default Laser 

Properties and other settings for a laser type. Left-click the Edit button in the top screen of the Laser 

tab to display the Laser Settings Editor. 

 

FIGURE 81: THE LASER TYPE SCREEN 

The Laser Settings Editor contains default laser properties and other settings for the laser type. Refer 

to "Laser Properties" on page 52 for descriptions of the default laser properties. 

Adding a New Laser Type 

Do the following to add a new laser type with the Laser Settings Editor: 

1. Click the Add laser file icon in the upper-left corner of the Laser Settings Editor. 

This creates a new laser type with the default name Custom Laser_n, where n is a unique numerical 

value. The settings for Custom Laser_n are displayed in the Laser Settings Editor. 

2. Modify settings for the new laser type in the Laser Settings Editor. 

3. Click the OK button to save the new laser type and exit the Laser Settings Editor. (Clicking 

the Cancel button will exit the Laser Settings Editor without saving the new laser type.) 
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Deleting a Laser Type 

Do the following to delete a laser type with the Laser Settings Editor: 

1. From the available list of laser types, select the laser type that you want to delete. 

2. Left-click Remove laser file icon  in the upper-left corner of the Laser Settings Editor. 

3. The following dialog box is displayed: 

 

FIGURE 82: THE LASER TYPE DELETION PROMPT 

 

4. Left-click the Yes button to delete the laser type. 

5. Note:  Left-clicking the No button will cancel the deletion. 

6. Left-click the OK button in the Laser Settings Editor to make the deletion permanent. 

7. Note:  Left-clicking the OK button in the Laser Settings Editor commits any changes made  

in the Laser Settings Editor since the last time the OK button was clicked. Left-clicking the 

Cancel button abandons any changes made in the Laser Settings Editor since the last time 

the OK button was clicked. 
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5.3.7 Controller 

The following figure shows the Controller tab of the Application Preferences window. You can use 

the Controller tab allows you to configure the Auto Connect feature for ScanMaster Designer. 

 

FIGURE 83: THE CONTROLLER TAB OF THE APPLICATION PREFERENCES WINDOW 

Select the devices that are to be auto connected upon ScanMaster Designer start-up by selecting the 

checkbox beside the device name. 

Connection retry timeout 

The Connection retry timeout is the length of time (in seconds) that ScanMaster Designer will 

attempt to automatically reconnect in the event of a connection failure. You can enter a value for 

this setting in the text box. 

Notify on failure 

Select the Notify on failure checkbox if you want to be notified of a connection attempt failure. 

Use as Default Device 

Select the Use as Default Device checkbox to use the currently selected device as the default device 

for connection. 



Managing Projects 

Version 3.2, Revision H 

5.3.8 External Hardware 

The following figure shows the External Hardware tab of the Application Preferences window. You 

can use the External Hardware tab to specify available hardware devices (such as XY-Tables) and 

their respective functions. 

 

 

FIGURE 84: THE EXTERNAL HARDWARE TAB OF THE APPLICATION PREFERENCES WINDOW 

 

Selecting a hardware file from the directory tree on the External Hardware tab displays its 

parameters. 

A hardware object can have many parameters which are used within its script. You can change the 

values of those parameters in the same page. 
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Creating a New Hardware File 

Do the following to create a new Hardware file: 

1. Left-click the Create Hardware icon   in the External Hardware tab. This displays the 

Hardware Import Wizard. 

 

FIGURE 85: THE HARDWARE IMPORT WIZARD 

 

2. Select one of the following options in the Hardware Import Wizard: 

¶ Select from library ς allows you to select an existing Hardware file. 

If you select this option, do the following: 

a. Select a Hardware file from the tree structure in the Hardware Import Wizard. 

b. Click the OK button in the Hardware Import Wizard. This exits the Hardware Import 

Wizard and saves the Hardware file in the External Hardware tab. 

¶ Create new entry ς allows you to create a new Hardware file. 

If you select this option, do the following: 
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a. Select the Hardware file type from the dropdown list in the Hardware Import 

Wizard. 

b. Type a name for the Hardware file in the Name field of the Hardware Import 

Wizard.  

c. Click the OK button in the Hardware Import Wizard. This exits the Hardware Import 

Wizard and saves the Hardware file in the External Hardware tab. 

 

Deleting a Hardware File 

To delete an existing hardware file, do the following in the External Hardware tab: 

1. Select the Hardware file that you want to delete. 

2. Left-click the Delete Hardware icon . 

3. The following dialog box is displayed: 

 

FIGURE 86: THE HARDWARE FILE DELETION PROMPT 

3. Left-click the Yes button to delete the hardware file. 

Note:  Left-clicking the No button will cancel the deletion. 

4. Left-click the OK button in the External Hardware tab to make the deletion permanent. 

Note:  Left-clicking the OK button in the External Hardware tab commits any changes made in 

the External Hardware tab since the last time the OK button was clicked. Left-clicking the Cancel 

button abandons any changes made in the External Hardware tab since the last time the OK 

button was clicked. 

 



Managing Projects 

Version 3.2, Revision H 

Creating a Hardware Object 

You can add a hardware to the project. To initialize a hardware object. 

1. Click the Hardware  button  located in the Hardware group in Project tab. The 

following dialog would be displayed: 

 

FIGURE 87: SELECT HARDWARE 

 

2. Select the Hardware to be used and click 'OK'. 

3. The Hardware object will be added. 

 

 

 

FIGURE 88 : HARDWARE OBJECT 

4. To enable editing right click on the selected hardware and use the context menu given. 

 

FIGURE 89 : CONTEXT MENU 

5.  After completing the editing user needs to Save Hardware to apply the changes. 

6.  Update function will apply the changes of the Hardware properties from other projects. 

7.  Delete function can be used to remove the selected hardware. 
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Properties 

Parameters 

 

FIGURE 90 : HARDWARE PROPERTIES 

User can add parameters using the add button, each parameter has a name, value and a description. 

Functions 

User can add an initialize function, move function and a GetLocation Function. These functions can be 

edited using the scripts. 

 

Script 

The ScanScript implementation corresponding to the selected hardware will be automatically 

implemented once the required members are selected. This code can be seen be turning in to the 

Script window by clicking the Script tab. 
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 FIGURE 91 : HARDWARE SCRIPT 

 

User can further modify the script to extent the behavior of the code as required. 

User can edit the add or delete scripts and edit the script name. 

FIGURE 92 : EDIT HARDWARE SCRIPT 
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5.3.9 Canvas (2D) 

The following figure shows the Canvas (2D) tab of the Application Preferences window. You can use 

the Canvas (2D) tab to specify the colors, grid spacing, and Nudge settings for the 2D Canvas in 

ScanMaster Designer. 

 

FIGURE 93: THE CANVAS (2D) TAB OF THE APPLICATION PREFERENCES WINDOW 

Canvas Colors 

The Canvas Colors section allows you to specify the colors of the canvas elements. 

To change the color of an element, left-click the color dropdown  and select the required color 

from the preset colors. (You can also use the More Colors option on the displayed menu, which 

allows you to specify RGB values to match a specific color.) 

Use defaults 

Click the Use Defaults button to reset the colors of the canvas elements to their default values. 
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Grid Spacing 

You can display the Grid as a rectangular pattern of lines or dots. The spacing between the grid lines 

is called "grid spacing". Use the following settings to specify the grid spacing values: 

¶ Inch Mode ς The grid spacing value when the Default Units is Inches 

¶ Millimeter Mode ς The grid spacing value when the Default Units is Millimeters 

Note:  The Default Units is specified in the General tab of the Application Preferences window. Refer 

to "General" on page 78 for more information on specifying the Default Units in the General tab of 

the Application Preferences window. 

Nudge 

The Nudge settings allow you to change how selected Shapes on the Drawing Canvas are moved 

when you press cursor keys. The Distance setting is the distance by which the Shape is moved in each 

step in the direction of the cursor key. The Mode setting determines whether the distance is 

measured in real units or pixels. 

If you hold a Control key while cursor key is pressed, the Shape will move 4 times the specified 

distance. If you hold a Shift key, the Shape will move one fourth of the specified distance. 
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5.3.10 Canvas (3D) 

The following figure shows the Canvas (3D) tab of the Application Preferences window. You can use 

the Canvas (3D) tab to specify the colors and grid spacing for the 3D Drawing Canvas in ScanMaster 

Designer. 

 

FIGURE 94: THE CANVAS (3D) TAB OF THE APPLICATION PREFERENCES WINDOW 

Canvas 3D Colors 

The Canvas 3D Colors section allows you to specify the colors of the canvas elements. 

To change the color of an element, left-click the color dropdown  and select the required color 

from the preset colors. (You can also use the More Colors option on the displayed menu, which 

allows you to specify RGB values to match a specific color.) 

Use defaults 

Click the Use Defaults button to reset the colors of the canvas elements to their default values. 
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Grid Spacing 

You can display the Grid as a rectangular pattern of lines or dots. The spacing between the grid lines 

is called "grid spacing". Use the following settings to specify the grid spacing values: 

¶ Inch Mode ς The grid spacing value when the Default Units is Inches 

¶ Millimeter Mode ς The grid spacing value when the Default Units is Millimeters 

Note:  The Default Units is specified in the General tab of the Application Preferences window. Refer 

to "General" on page 78 for more information on specifying the Default Units in the General tab of 

the Application Preferences window. 

5.3.11 Tiling 

Select the default values for the tiling automation object of the ScanMaster project. These settings 

will be use to initialize a new tiling object every time it gets created. 

The tiling object preferences are categorized in to three sections namely,  

1. General  

2. Friendly Names  

3. Post Process 

General 

In the general section following settings are available 

 

FIGURE 95: PREFERENCES, GENERAL TAB 
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Hide Tiling Initialize Window:  

Select this option to avoid showing the tiling wizard window, each time you create a new tiling 

object. A tiling object with the last selected default values will be added to the project.  

Grid type and Orientation selection: 

Set default properties for grid type and orientation for the tiling object.  

Note: Refer Process Automation, Tiling for more details.  

Tiling Arrangement Selection 

Select the default layout of the cells and the default sizes for the tiling object 

Note: Refer Process Automation, Tiling for more details.  

Friendly Names: 

 

FIGURE 96: PREFERENCES, FRIENDLY NAMES TAB 

In a multi scan head environments, each marking head may be designated with a friendly name. The 

friendly names can be assigned to the cells in your default tiling grid, to choose a default marking 

head, on which that cell will be marked.  

Tiling Grid Size:  

Set the tiling grid size of your scanning environment. Enter the Column size, Row size and press 

enter. A small grid view will be created on the right side. You can click on a cell to select it.  
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Marking Head Selection: 

Select a specific cell or set of cells and assign a friendly name (i.e. A marking head) to it. The Selection 

mode allows selecting a specific cell, a row, column or all the cells or to select a single cell simply click 

on the small grid view on the right. Use the friendly name text box to specify the friendly name of the 

marking head to use.  

Post Process : 

 

FIGURE 97: PREFERENCES, POST PROCESS TAB 

The post process consists of one setting which allows to control the hatching boundaries of each 

shape after tiling. In some situations, shapes may get divided along the tiling boundaries and if the 

shapes were hatched before, tiling could introduce small imperfections along the tiling boundaries. 

To fine tune further this setting will allow either to keep the hatching boundaries intact after tiling 

OR it can modify the hatching boundaries to match the tiling boundaries and regenerate the hatching 

area for qualified shapes.  

Example: 

If the tiling grid breaks down an initially closed shape in to several open segments (Left part of the 

below picture), you can use this feature to close all those open segments along the cell boundaries 

and regenerate hatching to each cell again. (Right part of the below picture) 
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FIGURE 98: PREFERENCES, REGENERATE THE HATCHING AREA 

5.3.12 Project Scripts 

The following figure shows the Project Scripts tab of the Application Preferences window. You can 

use the Project Scripts tab to specify the Default User Script File and the scripts that will be executed 

before or after the Default User Script File. 

 

FIGURE 99: THE PROJECT SCRIPTS TAB OF THE APPLICATION PREFERENCES WINDOW 

To specify a script, left-click the Browse button to browse to an existing script. Any script that you 

select must be in the Laser ScanScript (*.lsc) file format. The scripts are typically created in the Script 

Window of the ScanMaster Designer GUI with the ScanScript programming language. 
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To specify a script, left-click the Browse button to browse to an existing script. Any script that you 

select must be in the Laser ScanScript (*.lsc) file format. The scripts are typically created in the Script 

Window of the ScanMaster Designer GUI with the ScanScript programming language. 

Pre-Script File (Runs before user script) 

When a script is inserted in this field, it will be run before the Default User Script File in the project. 

Post-Script File (Runs after user script) 

When a script is inserted in this field, it will be run after the Default User Script File in the project. 

Default User Script File 

When a script is inserted in this field, it will be run as the default script when a new project is 

created. 

5.3.13 Transformation 

The following figure shows the Transformation tab of the Application Preferences window. You can 

use the Transformation tab to set Offset and Rotation settings. These settings will be applied to the 

whole project including Images, Automation Objects, Hardware, and 3D Engravings. 

 

 

 

 

 

 

 

 

 

 

 

FIGURE 100: THE TRANSFORMATION TAB OF THE APPLICATION PREFERENCES WINDOW 
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Transform Enable 

When Transform Enable is selected, the Offset, Rotation, and Invert settings on the Transformation 

tab will be automatically applied to the whole project. When Transform Enable is deselected, these 

settings will not be automatically applied to the whole project. 

¶ Offsets - Is the movement to a specific direction. You can specify the related X, Y and 

Z offsets which would be applied to the whole project. 

¶ Rotation - Is the motion around a specific point in a plane. You may specify the 

values for Angle, X Reference and Y Reference which will be applied to entire 

project.  

¶ Invert X/Y ς Swaps X and Y orientations. 

X offset 

The X offset setting is the X-axis offset specified in the default units (Millimeters or Inches). 

Y offset 

The Y offset setting is the Y-axis offset specified in the default units (Millimeters or Inches). 

Z offset 

The Z offset setting is the Z-axis offset specified in the default units (Millimeters or Inches). 

Angle 

The Angle setting is the angle of rotation around the point specified by X Reference and Y Reference. 

X Reference 

The X Reference setting is the X coordinate of the point that serves as the center of the angle of 

rotation. (The angle of rotation is specified in the above-described Angle setting.) 

Y Reference 

The Y Reference setting is the Y coordinate of the point that serves as the center of the angle of 

rotation. (The angle of rotation is specified in the above-described Angle setting.) 
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5.3.14 Marking Area 

The following figure shows the Marking Area tab of the Application Preferences window. You can 

use the Marking Area tab to change the marking area width and height. It also shows the top and 

bottom field dimensions if it is a 3D galvo. 

 

 

FIGURE 101: THE MARKING AREA TAB OF THE APPLICATION PREFERENCES WINDOW 

 

In order to change the field size, enter the Base Field Dimension Width and Height. Or else, if 

ScanMaster Designer is connected to a device and is currently selected, you can automatically 

populate the values by clicking on the Get From Device button. 
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5.4 CREATING A NEW PROJECT 

To create a new project, left-click the New icon from the Home tab or press Ctrl + N. 

  
Figure 102: Main Screen 

5.4.1 Adding an Image to a Project 

You can add an image to a project from the Ribbon or from the Project Explorer. 

When you add an image, it appears on the Canvas and is listed in the Images tree of the Project 

Explorer. The new image has the default name of Imagen, where n is a unique numerical value. 

 

Adding an Image from the Ribbon 

To add an image from the Ribbon, left-click the 2D Image icon  on the Project tab. 
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Adding an Image from the Project Explorer 

To add an image from the Project Explorer, do the following: 

1. Right-click the project name in the Project Explorer. 

2. Select Create 2D Image from the popup menu. 

 

 

FIGURE 103: SELECTING CREATE 2D IMAGE FROM THE POPUP MENU 
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5.5 OPENING AN EXISTING PROJECT 

Do the following to open a previously saved ScanMaster Designer (*.sdw) project: 

1. Choose Open  from the Home tab, press Ctrl+O, or do one of the following from the 

Ribbon: 

¶ Left-click the Open icon  on the Home tab or 

¶ Select the Open option from the File menu. 

2. The Open dialog box will be displayed. Browse to the desired project and highlight it. 

 

FIGURE 104: OPEN AN EXISTING PROJECT 

3. Left-click the Open Button in the Open dialog box. The selected project will be loaded into 

ScanMaster Designer. 

Note:  The name of the currently loaded project appears on the highlighted tab at the top of the 

ScanMaster Designer Drawing Canvas. For example, Plastic Marking is the currently loaded project in 

the following example. 
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FIGURE 105: THE CURRENTLY LOADED PROJECT IN SCANMASTER DESIGNER 
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5.6 CLOSING A PROJECT 

ScanMaster Designer allows users to close already open Projects individually. You can close a Project 

from the Project Name tab or from the File menu. 

5.6.1 Closing a Project from the Project Name Tab 

Do the following to close a project from the project name tab: 

1. Place the screen cursor on the Close icon  for the name tab of the project that you want to 

close. 

In the following example, the screen cursor has been placed on the Close icon for the Plastic 

Marking project, which is now red. 

 

FIGURE 106: THE CLOSE ICON ON A PROJECT NAME TAB 

2. Left-click the red Close icon  on the Project Name tab. If the project does not contain any 

unsaved changes, it is immediately closed. 

If the project contains any unsaved changes, the following dialog box is displayed. 

 

FIGURE 107: THE CLOSE ICON ON A PROJECT NAME TAB 

3. Left-click the Yes button to save the changes and close the project. 

Note:  Left-clicking the No button will abandon the unsaved changes and close the project.  

Left-clicking the Cancel button will abandon the close operation and leave the project open. 
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5.6.2 Closing a Project from the File Menu 

The currently loaded Project can be closed from the File menu. (The Project Name tab of the 

currently loaded Project is highlighted as shown in Figure 105:"The Currently Loaded Project in 

ScanMaster Designer" on page 112. See "Closing a Project from the Project Name Tab" on page 113 

to close a Project other than the one that is currently loaded.) 

Do the following to close the currently loaded Project from the File menu: 

1. Left-click on the File tab and select the Close option from the File menu. 

 

 

 

 

 

 

 

 

 

 

FIGURE 108: CLOSE PROJECT 

2. If the Project does not contain any unsaved changes, it is immediately closed. If the Project 

contains any unsaved changes, the following dialog box is displayed. 

 

FIGURE 109: THE CLOSE ICON ON A PROJECT NAME TAB 

3. Left-click the Yes button to save the changes and close the Project. 

Note:  Left-clicking the No button will abandon the unsaved changes and close the Project.  

Left-clicking the Cancel button will abandon the close operation and leave the Project open. 
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5.7 SAVING A PROJECT 

You can use the Save and Save As commands to store your work. The first time an 

unnamed Project is saved, the Save As dialog box appears. ScanMaster Designer saves its drawing 

projects as files with extensions ending in .sdw. 

1. Choose Save or Save As on the Home | Standard panel. 

The Save As dialog box will appear. 

2. Type a new name for the Project or keep the existing name. 

3. Click Save. 

5.8 EXPORTING A PROJECT 

ScanMaster Designer allows you to export images as .svi files to a location on the host machine or on 

the scan control card. 

1. Click Export on the Home | Standard panel. 

2. The Save As dialog box will appear. Select the preferred location to save the image. 

3. Enter a file name. 

4. Click Save. 
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6 WORKING WITH SHAPES AND TEXT 

6.1 THE DRAWING SHAPES TOOLBAR 

The Drawing Shapes Toolbar provides commands for drawing shapes and inserting text, raster 

images, vector images, barcodes, and spirals. The following figure contains an illustration of the 

Drawing Shapes Toolbar.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

FIGURE 110: THE DRAWING SHAPES TOOLBAR 

To insert a shape, click its icon on the Drawing Shapes Toolbar. Some tools in the Drawing shapes 

toolbar have additional hidden tools. To select a hidden tool, click the small triangle below the shape 

icon. 
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6.2 BASICS OF INSERTING SHAPES 

You can insert a Shape by using the mouse or by entering parameters. 

6.2.1 Using the Mouse to Insert a Shape 

Do the following to insert a shape by using the mouse: 

1. Left-click a shape icon on the Drawing Shapes Toolbar. 

2. Place a cursor anywhere on the Drawing Canvas and click the left mouse button again. 

You may have to drag the mouse and click on additional locations to draw the intended shape. 
Note:  The following sections provide overviews of the two main methods for inserting shapes from 

the Drawing Shapes Toolbar. 

Refer to the following sections for the details of how to insert shapes with each icon on the Drawing 

Shapes Toolbar: 

¶ "Geometric Shapes" on page 119 

¶ "Enter and Modify Text " on page 168 

¶ "Path Text" on page 217 

¶ "Vector Image" on page 224 

¶ "Raster Image" on page 228 

¶ "Drill Shapes" on page 255 

¶ "Barcode Shapes" on page 263 

6.2.2 Entering Parameters to Insert a Shape 

Do the following to insert a shape by entering parameters: 

1. Left-click a shape icon on the Drawing Shapes Toolbar. 

2. Place the cursor anywhere on the Drawing Canvas. The following box will appear.  

 

 

 

 

FIGURE 111: PARAMETER ENTRY BOXES 
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3. Enter the X coordinate of the starting point in the first box. (The first box is highlighted as 

shown in the above figure.) 

4. Press the tab key to highlight the second box. 

5. Enter the Y coordinate of the starting point and press the Enter key. Repeat this process to 

enter the coordinates of the next point, and so, on until the desired shape is formed. 

For example, by repeating the following steps you can draw a circle: 

1. On the Drawing Shapes Toolbar, left-click the arrowhead on the Insert Circle icon  to 

display the Insert Circle popup. 

 

FIGURE 112: THE INSERT CIRCLE POPUP 

2. Select the Center and Radius option from the Insert Circle popup. 

 

3. Move the screen cursor onto the Drawing Canvas and enter the coordinates of the center 

point of the circle (-10, 20). 

 

FIGURE 113: ENTERING COORDINATES OF THE CENTER OF THE CIRCLE 

4. Press the Enter key. 

5. Enter the radius (50) and press the Enter key. 

The following figure shows the circle that would be created by executing the preceding steps. 
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FIGURE 114: THE INSERTED CIRCLE 

6.3 GEOMETRIC SHAPES 

The following geometric Shapes can be inserted with the Drawing Shapes Toolbar in ScanMaster 

Designer: 

¶ Dot ¶ Symmetric Polygon 

¶ Line ¶ Ellipse 

¶ Circle ¶ Elliptical Arc 

¶ Arc ¶ Bezier Path 

¶ Polyline ¶ Spiral 

¶ Rectangle ¶ Path 

 

6.3.1 Insert a Dot 

The Insert Dot tool will insert a dot in your drawing at a position that you select on the Drawing 

Canvas. 

Do the following to insert a dot on the Drawing Canvas: 

1. Left-click the Dot icon  on the Drawing Shapes Toolbar. 

2. Left-click anywhere on the Drawing Canvas to place the dot. 
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FIGURE 115: DOT 

Note:  A dot is indicated by a pixel at the center and a cross for more visibility. 

Moving a Dot 

A dot has a single hotspot, which represents the location coordinates of the dot. For example, the 

dot in the following figure has location coordinates of (-56.8854, -55.6948) as shown in the yellow-

highlighted fields on the lower-left corner of the figure. 

 

FIGURE 116: A DOT HOTSPOT 

You can use the dot hotspot to move the dot. 

 

Do the following to move a dot by its hotspot: 

1. Select the dot and place the mouse over the dot hotspot. 

2. Press the left mouse button and hold it down while you drag the mouse and the dot to the 

desired location. 

3. When the dot is at the desired location, release and click the left mouse button. The 

following figure shows an example of a dot that has been moved by dragging its hotspot. 
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FIGURE 117: MOVING A DOT BY DRAGGING ITS HOTSPOT 

 

You can also move a Dot by nudging or by using the Move or Move to Origin tool. Refer to "Moving 

Shapes" on page 312 to move a Dot by any of these methods. 

Note:  You cannot move a Dot by dragging on a non-hotspot area because there are no non-hotspot 

areas on a Dot. 

 

Dot Properties 

When you select a dot in the Drawing Canvas, its properties will be displayed in the Properties 

window of ScanMaster Designer. You can change the dot's position by giving different parameter 

values through the Properties window. 
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The dot properties are the following: 

X ς The X coordinate of the dot 

Y ς The Y coordinate of the dot 

Z ς The Z coordinate of the dot 

Note:  The Z property is only used for scanning on 3-Axis 

systems. The range of allowable values for the Z property 

is defined in the Marking Area tab of the Project Settings 

tab. 

Dot Duration ς The length of time (in microseconds) the 

laser will dwell in this location 

 

FIGURE 118: DOT PROPERTIES 

6.3.2 Insert a Line 

The Insert Line tool will draw a single straight line from one point to another. A line has two ends: 

the start point and the end point. There are two methods of drawing a line: 2 Points and Length and 

Angle.  

2 Points 

The 2 Points method will draw a line from one point to another. 

Do the following to draw a line with the 2 Points method: 

1. On the Drawing Shapes Toolbar, left-click the arrowhead below the Insert Line icon  to 

display the Insert Line popup. 

2. Select the 2 Points option from the Insert Line popup. 

 

FIGURE 119: THE INSERT LINE POPUP 
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3. On the Drawing Canvas, place the crosshairs on the starting point and click the left mouse 

button. When you move the crosshairs, you will see a preview of the line. 

4. Move the crosshairs to the end point and click the left mouse button. 

 

FIGURE 120: INSERTING A LINE WITH THE 2 POINTS OPTION 

 

Length and Angle 

The Length and Angle method is used to draw lines by entering the desired length and angle. 

Do the following to draw a line with the Length and Angle method: 

1. On the Drawing Shapes Toolbar, left-click the arrowhead below the Insert Line icon  to 

display the Insert Line popup. 

  

 

 

 

FIGURE 121: THE INSERT LINE POPUP 

2. Select the Length and Angle option from the Insert Line popup. 

3. On the canvas, place the crosshairs on the starting point and click the left mouse button. 

When you move the crosshairs, you will see a preview of the line. 
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4. Move the mouse until the line is of the desired length and angle. Then click the left mouse 

button to specify the endpoint of the line. 

5. If you are concerned about the exact dimensions of the line, you may specify the exact length 

and/or angle in the boxes that appear next to the length and angle indicators. Use the Tab 

key to toggle between these boxes. You can enter one of them in the box and use the mouse 

to specify the other. 

 

FIGURE 122: LINE - LENGTH & ANGLE 

Note:  When drawing lines at an angle, you can start measuring the angle at 0 degrees, which is a 

horizontal line. If you draw a line at 90 degrees, the line will be a vertical line. 
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Line Properties 

When you select a line in the Drawing Canvas, its properties will be displayed in the Properties 

window of ScanMaster Designer. You can change the length, position, or angle of the line by giving it 

different parameter values through the Properties window. 

The line properties are the following: 

¶ Start X ς The X coordinate of the line start 

point 

¶ Start Y ς The Y coordinate of the line start 

point 

¶ Start Z ς The Z coordinate of the line start 

point 

¶ End X ς The X coordinate of the line end 

point 

¶ End Y ς The Y coordinate of the line end 

point 

¶ End Z ς The Z coordinate of the line end 

point 

¶ Note:  The Z properties (Start Z and End Z) 

are only used for scanning on 3-Axis 

systems. The range of allowable values for 

the Z properties is defined in the Marking 

Area tab of the Project Settings tab. 

¶ Length ς The length of the line 

 

FIGURE 123: LINE PROPERTIES 

Note:  The Length parameter is displayed for informational purposes only and cannot be changed in 

the Properties tab. 

Changing Line Properties by Moving Hotspots 

You can change line properties by moving line hotspots as described in the following sections: 

¶ "Error! Reference source not found." on page Error! Bookmark not defined. 

describes how to change the length and angle of a line by moving its endpoint 

hotspots. 

¶ "Dragging by a centerpoint hotspot or a midpoint hotspot" on page 313 describes 

how to move a line without changing its length or angle. 
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¶ "Rotating Shapes" on page 323 describes how to change the angle (of rotation) of a 

line. 
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6.3.3 Insert a Circle 

The Insert Circle tool will draw a circle by one of several methods. Click the arrowhead beneath the 

Insert Circle icon  to access the Insert Circle popup, which lists the following options: 

¶ 2 Point Circle 

¶ 3 Point Circle 

¶ Center and Radius 

¶ Center and Diameter 

¶ Tangent Tangent Radius 

To draw a 2 Point Circle 

The 2 Point Circle method will draw a circle using a line, which represents the diameter of the circle. 

Do the following to draw a circle with the 2 Point Circle method: 

1. On the Drawing Shapes Toolbar, left-click the 

arrowhead below the Insert Circle icon  to 

display the Insert Circle popup. 

2. Select the 2 Point Circle option from the Insert 

Circle popup. 

3. Place the crosshairs on any location on the 

Drawing Canvas. 
 

FIGURE 124: THE INSERT CIRCLE POPUP 

4. Click the left mouse button and move the crosshairs in the desired direction and to the 

required size. The circle will be previewed as you move the crosshairs. 

 

 

 

 

FIGURE125: INSERTING A CIRCLE WITH THE 2 POINT OPTION 

5. When the circle is at the desired size, click the left mouse button. The finished circle is 

displayed. 

https://d.docs.live.net/548dfe7b0105be0e/Documents/CT%20Manuals/ScanMaster%20Designer%20User%20Manual.docx#-1091772770
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https://d.docs.live.net/548dfe7b0105be0e/Documents/CT%20Manuals/ScanMaster%20Designer%20User%20Manual.docx#-2051871873
https://d.docs.live.net/548dfe7b0105be0e/Documents/CT%20Manuals/ScanMaster%20Designer%20User%20Manual.docx#-1201800462
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https://d.docs.live.net/548dfe7b0105be0e/Documents/CT%20Manuals/ScanMaster%20Designer%20User%20Manual.docx#DrillPatterns






















































































































































































































































































































































































































































































































































































































mailto:photonics@novanta.com

	Table of Contents
	1.1 Safety Symbols 1
	1.2 Safety Labels 2
	1.3 Customer Support 2
	2.1 General Notes 4
	2.2 ScanMaster Architecture 4
	2.3 Document Conventions Project Concepts 7
	2.4 Scan Controllers 8
	2.5 Using ScanMaster Designer Help 8
	3.1 System Requirements 13
	3.2 ScanMaster Designer Installation 13
	3.3 Starting ScanMaster Designer 17
	3.4 Exiting ScanMaster Designer 19
	3.5 Workspace Elements 20
	3.6 Recommended Workflow 20
	3.7 Job Creation Example 23
	3.8 What is Laser Marking? 24
	3.9 Scan Controller Cards 24
	4.1 The File tab 25
	4.2 Quick Access Toolbar 26
	4.3 The Ribbon 27
	4.4 The Drawing Canvas and the Script Window 38
	4.5 Project Explorer 41
	4.6 Shape Tree 46
	4.7 Properties Window 49
	4.8 Laser Properties - Quality Tab 52
	4.9 Connecting to Devices 65
	4.10 Output Window 66
	4.11 Role-based Access Control 69
	5.1 Before you create a new Project 76
	5.2 Preferences vs. Settings 76
	5.3 The Application Preferences Window 78
	5.4 Creating a New Project 109
	5.5 Opening an existing Project 111
	5.6 Closing a Project 113
	5.7 Saving a Project 115
	5.8 Exporting a Project 115
	6.1 The Drawing Shapes Toolbar 116
	6.2 Basics of Inserting Shapes 117
	6.3 Geometric Shapes 119
	6.4 Enter and Modify Text in a Drawing 168
	6.5 Vector Images 224
	6.6 Raster Images 228
	6.7 Drill Shapes 255
	6.8 Barcode Shapes 263
	6.9 Barcode Properties 267
	7.1 Changing the view 277
	7.2 Selecting Shapes 280
	7.3 Hotspot Editing 282
	7.4 Moving the Endpoint Hotspots on a Line 283
	7.5 Editing Shapes 310
	7.6 Paste on absolute position 311
	7.7 Moving Shapes 312
	7.8 Cloning Shapes 315
	7.9 Scaling Shapes 315
	7.10 Rotating Shapes 323
	7.11 Mirroring Shapes 325
	7.12 Arranging Shapes 327
	7.13 Undo and Redo 333
	8.1 Hatch Operations 335
	8.2 Array Operations 352
	8.3 Modifying Operations 376
	8.4 Optimize Operations 391
	8.5 Quality Operations 400
	9.1 Tiling 405
	9.2 Tray Marking 448
	9.3 Database Connectivity 472
	9.4 ScanScript Assistant 487
	9.5 Dll Automation 487
	10.1 Connecting to Devices 493
	10.2 Laser Marking Operations 495
	10.3 Working with jobs 497
	10.4 IO Bits Monitor 500
	10.5 Configuring Devices 500
	10.6 SMC Device Configuration Editor 501
	10.7 Laser Diagnostics 522
	11.1 About Language Construct 524
	11.2 Control Structures 525
	11.3 ScanScript Commands 529
	11.4 ScanScript Execution Model 530
	11.5 To start scripting 532
	12.1 Extention Folder 536
	12.2 Send and receive arguments to the ScanMaster API 541
	13.1 Snap Commands 544
	13.2 ScanMaster Designer Shortcut Keys 554

	List of Figures
	1 Important Information
	1.1 Safety Symbols
	1.2 Safety Labels
	1.3 Customer Support
	Americas, Asia Pacific
	Europe, Middle East, Africa
	China
	Japan


	2 Introduction
	2.1 General Notes
	2.2 ScanMaster Architecture
	2.3 Document Conventions Project Concepts
	2.4 Scan Controllers
	2.5 Using ScanMaster Designer Help
	Finding a Help Topic
	2.5.1 Contents tab
	2.5.2 Index tab
	2.5.3 Search tab
	2.5.4 Favorites tab
	2.5.5 Printing a Help Topic
	2.5.6 Copying Examples


	3 Getting Started
	3.1 System Requirements
	3.2 ScanMaster Designer Installation
	3.2.1 To install ScanMaster Designer
	3.2.2 Uninstalling ScanMaster Designer
	3.2.3 Repairing or ScanMaster Designer

	3.3 Starting ScanMaster Designer
	3.3.1 Starting ScanMaster Designer from Your Desktop
	3.3.2 Starting ScanMaster Designer from Your Start Menu

	3.4 Exiting ScanMaster Designer
	3.5 Workspace Elements
	3.6 Recommended Workflow
	3.7 Job Creation Example
	3.8 What is Laser Marking?
	3.9 Scan Controller Cards

	4 The ScanMaster Designer Interface
	4.1 The File tab
	4.2 Quick Access Toolbar
	4.2.1 Customize the Quick Access Toolbar
	4.2.2 Place the Quick Access Toolbar above/below the ribbon

	4.3 The Ribbon
	4.3.1 Minimize/Maximize the ribbon
	4.3.2 Home
	Standard
	Edit
	View
	Mark

	4.3.3 Project
	Basic Elements
	Automation
	Marking Process
	Hardware

	4.3.4 Tools
	Transform
	Array
	Modify
	Hatch
	Quality
	Optimize

	4.3.5 Arrange
	Align
	Make Same Size
	Horizontally Distribute
	Vertically Distribute
	Spacing
	Measure


	4.4 The Drawing Canvas and the Script Window
	4.4.1 The Drawing Canvas
	Grid
	Snap Tools

	4.4.2 Script Window

	4.5 Project Explorer
	Create a New 2D Image
	Import an Existing 2D Image (Import Image File)
	Open an Image for editing
	Delete an existing Image
	Rename an Image
	Export an Image
	Reorder Images

	4.6 Shape Tree
	4.6.1 Layers
	Add a Layer
	Remove a Layer
	Rename a Layer
	Changing Layer Properties

	4.6.2 To Enable or Disable Marking

	4.7 Properties Window
	4.7.1 Shape Properties
	4.7.2 Laser Properties
	Laser Properties – General Tab


	4.8 Laser Properties - Quality Tab
	Mark Delay
	Jump Delay
	Poly Delay
	Laser On Delay
	Laser Off Delay
	Laser Pipeline Delay
	Velocity Compensation
	Accuracy
	4.8.1 Profiles
	Working with Profiles in the Material Library
	Load a Profile
	Add new folders
	Rename a Profile
	Delete a Profile
	Add a new Profile to the Material Library
	Searching for a Profile
	Copy and paste Profiles
	Laser Variables


	4.9 Connecting to Devices
	4.9.1 Connect to a particular card
	4.9.2 Disconnect a Scan Controller

	4.10 Output Window
	4.10.1 Arranging windows and panels on the screen
	Move panels in the ScanMaster Designer window


	4.11 Role-based Access Control
	4.11.1 Users
	Add new users
	Remove users

	4.11.2 Add a new role
	4.11.3 Enable Login
	Change Password

	4.11.4 Export/Import Login Data
	4.11.5 User Logging
	4.11.6 User Files


	5 Managing Projects
	5.1 Before you create a new Project
	5.2 Preferences vs. Settings
	5.3 The Application Preferences Window
	5.3.1 General
	Default Units
	Language
	Output Window
	Script Assistant
	Number Format
	External Tools
	Adding an External Tool
	Removing an External Tool
	Tool ordering
	Resetting the Docking GUI Layout and Quick Access Bar
	Large Image View Option

	5.3.2 Keyboard Shortcuts
	5.3.3 Saving
	Auto Recovery
	Embed Scanning Information

	5.3.4 Application Folders
	Users and Groups

	5.3.5 Laser
	Laser Options Tab
	Laser Type
	Beam width
	Marking Quality Maximum Error
	Enable image streaming by default
	Align/Trace Options Tab
	Speed/Counts Settings
	Delay settings

	5.3.6 Laser Settings Editor
	Adding a New Laser Type
	Deleting a Laser Type

	5.3.7 Controller
	Connection retry timeout
	Notify on failure
	Use as Default Device

	5.3.8 External Hardware
	Creating a New Hardware File
	Deleting a Hardware File
	Creating a Hardware Object
	Properties
	Script

	5.3.9 Canvas (2D)
	Canvas Colors
	Use defaults
	Grid Spacing
	Nudge

	5.3.10 Canvas (3D)
	Canvas 3D Colors
	Use defaults
	Grid Spacing

	5.3.11 Tiling
	General

	5.3.12 Project Scripts
	Pre-Script File (Runs before user script)
	Post-Script File (Runs after user script)
	Default User Script File

	5.3.13 Transformation
	Transform Enable
	X offset
	Y offset
	Z offset
	Angle
	X Reference
	Y Reference

	5.3.14 Marking Area

	5.4 Creating a New Project
	5.4.1 Adding an Image to a Project
	Adding an Image from the Ribbon
	Adding an Image from the Project Explorer


	5.5 Opening an existing Project
	5.6 Closing a Project
	5.6.1 Closing a Project from the Project Name Tab
	5.6.2 Closing a Project from the File Menu

	5.7 Saving a Project
	5.8 Exporting a Project

	6 Working with Shapes and Text
	6.1 The Drawing Shapes Toolbar
	6.2 Basics of Inserting Shapes
	6.2.1 Using the Mouse to Insert a Shape
	6.2.2 Entering Parameters to Insert a Shape

	6.3 Geometric Shapes
	6.3.1 Insert a Dot
	Moving a Dot
	Dot Properties

	6.3.2 Insert a Line
	2 Points
	Length and Angle
	Line Properties
	Changing Line Properties by Moving Hotspots

	6.3.3 Insert a Circle
	To draw a 2 Point Circle
	To draw a 3 Point Circle
	To draw a Center and Diameter Circle
	To draw a Tangent, Tangent & Radius Circle
	Circle Properties
	Changing Circle Properties by Moving Hotspots

	6.3.4 Insert an Arc
	To draw a Start, End and Center Arc
	To draw a Start, Center and Sweep Angle Arc
	To draw a Center, Start and Sweep Angle Arc
	To draw a 3 Point Arc
	Arc Properties
	Changing Arc Properties by Moving Hotspots

	6.3.5 Insert a Polyline
	Points
	Segment Length and Angle
	Polyline Properties
	Changing Polyline Properties by Moving Hotspots

	6.3.6 Insert a Rectangle
	Rectangle Properties
	Changing Rectangle Properties by Moving Hotspots

	6.3.7 Insert a Symmetric Polygon
	Symmetric Polygon Properties
	Changing Symmetric Polygon Properties by Moving Hotspots

	6.3.8 Insert an Ellipse
	Center, Major Length and Angle, Minor Length
	Major Axis, Minor Axis Length
	Ellipse Properties
	Changing Ellipse Properties by Moving Hotspots

	6.3.9 Insert an Elliptical Arc
	A, B, Start Angle, Sweep Angle
	Center, A, B, Start Angle, Sweep Angle
	Elliptical Arc Properties
	Changing Elliptical Arc Properties by Moving Hotspots

	6.3.10 Insert a Bezier Path
	Bezier Path
	Free Hand Drawing
	Bezier Path Controls
	Cusp Node
	Smooth Node
	Bezier Path Properties
	Changing Bezier Path Properties by Moving Hotspots

	6.3.11 Insert a Path
	Draw a Polyline in a Path
	Draw an Arc in a Path
	Draw a Bezier Path
	Path Properties
	Changing Path Properties by Moving Hotspots

	6.3.12 Insert a Spiral
	Spiral Properties
	Changing Spiral Properties by Moving Hotspots


	6.4 Enter and Modify Text in a Drawing
	6.4.1 Insert Text in a Drawing
	To change the size of the entered text
	To change the size of the text box
	To edit text
	Text Properties

	6.4.2 Basic Text Formatting
	6.4.3 Dynamic Text
	User-Defined Variable
	Formatted Strings
	Flags
	Width
	Precision
	Specifier
	Date
	Time

	6.4.4 Cutting Text with the Cut Icon
	6.4.5 Copying Text with the Copy Icon
	6.4.6 Pasting Text with the Paste Icon
	6.4.7 Zooming Text with the Zoom Factor Dropdown
	6.4.8 Superscript and Subscript
	Formatting Text as Superscript with the Superscript Icon
	Formatting Text as Subscript with the Subscript Icon
	Setting Superscript and Subscript Scale Factors with the Scale Factors Icon

	6.4.9 Turning Characters Upside Down with the Upside Down Icon
	6.4.10 Reversing Characters with the Backward Icon
	6.4.11 Changing the Text Font
	6.4.12 Undoing the Last Action with the Undo Icon
	6.4.13 Redoing an Undone Action with the Redo Icon
	6.4.14 Changing the Text Height
	6.4.15  Setting the Horizontal Character Gap with the Character Gap Icon
	6.4.16 Making Text Bold
	6.4.17 Making Text Italic
	6.4.18 Setting Text Kerning
	6.4.19 Applying Hatching Patterns to Text
	Line Hatch
	Offset Hatch
	Offset In-Out Hatch
	Helix Hatch
	Clearing All Hatching
	Showing and Hiding Hatching
	Removing Hatching
	Toggling the marking of the outer border on hatched text
	Applying Word Wrapping to Text

	6.4.20 Formatting Tools on the Character Tab
	Rotation Angle
	Oblique Angle
	Scale X
	Scale Y
	Line Space
	Specifying Line Spacing as a Factor of Font Size
	Specifying Line Spacing as an Exact Value
	Text Alignment

	6.4.21 Unicode Support
	Using the Language Pack
	Using the Alt key
	Using an Input Method Editor
	Using the Windows Character Map

	6.4.22 Inserting Path Text
	Path Text Properties
	Align
	Direction
	Start Offset
	Elevation
	Distance to path
	Deform
	Associativity


	6.5 Vector Images
	6.5.1 Inserting a Vector Image using Location & Size
	6.5.2 Inserting a Vector Image using Absolute Units

	6.6 Raster Images
	6.6.1 Insert Raster Images
	6.6.2 Image Processing Operations
	Grayscale
	Invert
	Contrast
	Brightness
	Error Diffusion
	Convert to Raster Image
	Reset Aspect Ratio
	Move to Origin
	Rotate
	Scale
	Update the Position of a Scaling Hotspot
	Entering Scaling Factors with the Scale Value Tool
	Clone
	Hatch
	Group
	Ungroup

	6.6.3 Change image properties
	Geometry Properties
	Rasterization Properties
	Methods of Raster Marking
	Pulse Width
	Power
	Laser On Time
	Jump and Fire
	Edit Profile
	Curve Graph
	Manually Edit the Table
	Save as Preset
	To load previously saved graphs
	To use Custom Patterns
	Advanced


	6.7 Drill Shapes
	6.7.1 Importing a drill shape using Location & Size
	6.7.2 Importing a drill shape using Absolute Units
	6.7.3 Drill Shape Properties

	6.8 Barcode Shapes
	6.8.1 Insert a Barcode
	6.8.2 Barcode Parameters
	Parameters That Are Common Across Barcode Types
	Type-specific Barcode Parameters


	6.9 Barcode Properties
	6.9.1 Properties of non-Data Matrix, non-QR, and non PDF Barcode Types
	6.9.2 Properties of the Data Matrix Barcode Type
	6.9.3 Properties of QR Barcode Types
	6.9.4 Properties of PDF Barcode Types
	Human Readable Text Support
	Enable Human Readable Text
	Human Readable Text properties
	Modify Font properties
	Line Hatch properties
	Font Embed for Dynamic Barcode
	Serial Number variable integration



	7 Modifying Shapes
	7.1 Changing the view
	7.1.1 To Zoom In/Zoom Out
	7.1.2 Pan
	7.1.3 Rotate
	7.1.4 Show Field
	7.1.5 Zoom Window
	7.1.6 Fit To All

	7.2 Selecting Shapes
	7.2.1 Hotspots on a Selected Shape
	7.2.2 Cutting, Copying, and Pasting Selected Shapes
	7.2.3 Moving Selected Shapes

	7.3 Hotspot Editing
	7.4 Moving the Endpoint Hotspots on a Line
	7.4.1 Moving Circle Hotspots to Change the Radius of a Circle
	7.4.2 Moving Arc Hotspots to Change Arc Attributes
	Moving an Endpoint Hotspot on an Arc
	Changing the Start Angle of an Arc
	Changing the Start Angle with the Arrow Hotspot
	Changing the Start Angle with the Start Angle Hotspot
	Changing the Sweep Angle of an Arc
	Changing the Radius of an Arc by Moving Hotspots

	7.4.3 Moving Polyline Endpoint Hotspots to Change Polyline Endpoints
	7.4.4 Moving Resizing Hotspots on Rectangular Shapes
	Moving Resizing Hotspots on Symmetric Polygons

	7.4.5 Moving Ellipse Hotspots to Change the Length or Width of an Ellipse
	7.4.6 Moving Hotspots to Change an Elliptical Arc
	Using a Vertex Hotspot to Change the Length of the Major Axis
	Using a Co-vertex Hotspot to Change the Length of the Minor Axis
	Using the Sweep Angle Hotspot to Change the Sweep Angle
	Using the Start Angle Hotspot to Change the Start Angle and the Sweep Angle

	7.4.7 Using Bezier Path Hotspots to Modify Bezier Path Transitions
	7.4.8 Moving Path Text Hotspots to Change the Path Text Location
	Changing the Start Offset of Path Text
	Changing the Path Text Distance

	7.4.9 Using Hotspots to Modify a Spiral
	Resizing a Spiral with Hotspots
	Changing the Outer Radius of a Spiral
	Changing the Inner Radius of a Spiral
	Changing the Pitch of a Spiral


	7.5 Editing Shapes
	7.5.1 Cut
	7.5.2 Copy
	7.5.3 Paste

	7.6 Paste on absolute position
	7.7 Moving Shapes
	7.7.1 Dragging by a non-hotspot area on the shape
	7.7.2 Dragging by a centerpoint hotspot or a midpoint hotspot
	7.7.3 Nudging
	7.7.4 Using the Move tool from the Tools | Transform panel
	7.7.5 Move to Origin

	7.8 Cloning Shapes
	7.9 Scaling Shapes
	7.9.1 Scaling with the boundary box popup menu
	7.9.2 Scale Value
	7.9.3 Scale Width
	7.9.4 Scale Height
	7.9.5 Scale to Rectangle

	7.10 Rotating Shapes
	7.10.1 Using the Rotate tool to rotate a Shape
	7.10.2 Using the arrow hotspot to rotate a Shape

	7.11 Mirroring Shapes
	7.12 Arranging Shapes
	7.12.1 The Arrange | Align Panel
	7.12.2 The Arrange | Make Same Size Panel
	7.12.3 The Arrange | Vertically Distribute Panel
	7.12.4 The Arrange | Spacing Panel
	7.12.5 The Arrange | Measure Panel

	7.13 Undo and Redo
	7.13.1 Undo
	7.13.2 Redo


	8 Advanced Shape Operations
	8.1 Hatch Operations
	8.1.1 Inserting a Hatch Pattern in a Shape
	8.1.2 Renaming a Hatching Pattern
	8.1.3 Hatch Types
	Line Hatch
	Offset Hatch
	Offset In Out Hatch
	Helix Hatch

	8.1.4 Filling multiple shapes with hatching
	8.1.5 Edit Hatch Parameters
	8.1.6 Remove Hatch Association
	8.1.7 Deleting a hatching pattern from a Shape

	8.2 Array Operations
	8.2.1 Rectangular Array
	Example of a Rectangular Array
	Modifying the Rectangular Array using hotspots
	Using hotspots to add or remove array rows and columns
	Using hotspots to change row or column offsets
	Using the Arrow hotspot to change the angle of rotation of a Rectangular Array

	8.2.2 Polar Array
	Creating a Polar Array
	Example of a Polar Array
	Modifying the Polar Array using hotspots
	Dragging the center point hotspot to move a Polar Array
	Rotating array elements by dragging the array element rotation hotspot
	Rotating around the center of an array element
	Rotating around the upper-left corner of an array element
	Rotating around the top-side midpoint of an array element
	Rotating around the upper-right corner of an array element
	Rotating around the right-side midpoint of an array element
	Rotating around the lower-right corner of an array element
	Rotating around the bottom-side midpoint of an array element
	Rotating around the lower-left corner of an array element
	Rotating around the left-side midpoint of an array element
	Changing the angle of rotation of the entire Polar Array
	Changing the radius of a Polar Array


	8.3 Modifying Operations
	8.3.1 Trim and extend shapes
	Trim
	Normal Mode
	Fence Mode
	Extend

	8.3.2 Join, break and divide
	Join
	Break
	Divide

	8.3.3 Explode shapes
	8.3.4 Group and ungroup Shapes
	Group
	Ungroup

	8.3.5 Fillet or chamfer shapes
	Fillet
	Chamfer

	8.3.6 Bridging Shapes

	8.4 Optimize Operations
	8.4.1 Show Jumps
	8.4.2 Marking Order
	Select the starting point of marking
	Reverse the marking direction
	To end ordering

	8.4.3 Path Optimize
	8.4.4 Directional Optimize
	8.4.5 Simplify Polylines

	8.5 Quality Operations
	8.5.1 Cutter Compensation
	8.5.2 Remove Overlaps
	8.5.3 Marking Quality
	8.5.4 Inserting Basic 3D Shapes


	9 Process Automation
	9.1 Tiling
	9.1.1 Initializing the Tiling Grid
	Initializing a LinearCell Grid Type
	Initializing a Mosaic or RectangularCell Grid Type
	Tiling Grid Properties
	Linear Grid Properties Window
	Rectangular and Mosaic Grid Properties Window
	Tiling grid location
	Dragging a linear or rectangular tiling grid to a new location
	Dragging a mosaic tiling grid to a new location
	X-Y table movement values
	The scan order
	Scan order settings for rectangular and mosaic grids
	The Starting Cell property for rectangular and mosaic tiling grids
	The Scan Direction option for rectangular and mosaic tiling grids
	The Scan Direction setting for linear tiling grids
	Scan Direction options for grids with a Vertical Tiling Orientation
	Scan Direction options for grids with a Horizontal Tiling Orientation
	Grid Information
	Grid Information for linear tiling grids
	Grid Information for rectangular tiling grids
	Resizing columns and rows in rectangular and linear tiling grids
	Resizing columns or rows by entering Column or Row coordinates
	Resizing columns or rows by selecting and dragging a cell border
	Adding and deleting columns
	Adding a column
	Deleting a column
	Making column widths equal
	Adding and deleting rows
	Adding a row
	Deleting a row
	Making row heights equal
	Swapping cell locations
	Converting a Linear or Rectangular tiling grid to a Mosaic tiling grid
	Isolating tiles
	Mosaic cell operations
	Changing the sizes and shapes of Mosaic cells
	The Join Vertex operation
	The Delete Line operation
	Dragging the hotspots on a tiling grid
	Adding an extra hotspot to a cell boundary line

	9.1.2 The Properties Tab
	Image Selection
	Tiling Mode
	Script Configuration
	Changing the variable name
	Selecting or creating a pre-execution ScanScript function
	Selecting or creating a post-execution ScanScript function
	Clearing the pre- or post-execution ScanScript function
	Optimization
	Overlapping Length
	Total Part Size
	Recalculate from image
	Hardware

	9.1.3 Edit Cells in the tiling grid
	Editing shape Properties

	9.1.4 Code View

	9.2 Tray Marking
	9.2.1 Initializing the Tray Grid
	Tray Properties
	General
	Grouping
	Cell Properties
	Tray Details
	Marking Direction
	The Starting Cell Option
	The Scan Direction Option
	Script
	Variable Name
	Selecting or creating pre-execution ScanScript function
	Selecting or creating a post-execution ScanScript function
	Cell View
	Cell Dimensions
	Recipe
	Selection
	Selection Mode Examples – All, Even Columns, and Even Rows
	Selection Mode Examples – Odd Columns, Odd Rows, and Rectangular Region
	Selection Mode Examples – Single Cell, Specific Column, and Specific Row
	Parameters
	Selected Images

	9.2.2 Scanning Options
	9.2.3 Aligning and Tracing Options
	Align
	Trace


	9.3 Database Connectivity
	9.3.1 Initializing the Database Connectivity instance
	From Database File
	Using ODBC Data Sources
	Predefined data source names
	Custom-building a connection string
	Creating a predefined data source name

	9.3.2 Query Management
	Defining (Adding) Queries
	Retrieving data from the Database
	Inserting data to the Database
	Updating data in the Database
	Editing Queries
	Deleting Queries


	9.4 ScanScript Assistant
	9.5 Dll Automation
	9.5.1 Initializing the Dll Automation Object
	9.5.2 Member Selection
	Selected Members

	9.5.3 Edit Selected Members
	9.5.4 Auto Generated Script


	10 Hardware-related Operations
	10.1 Connecting to Devices
	Connect to a particular card
	Disconnect from a card

	10.2 Laser Marking Operations
	Scan Project
	Scan Active Image
	Scan Selected Shapes
	10.2.1 Start, pause, stop marking
	Start
	Pause
	Stop

	10.2.2 Trace shapes before marking
	Trace
	Align


	10.3 Working with jobs
	10.3.1 Downloading Scanning Jobs
	To download scanning jobs
	Managing jobs
	View scanning jobs
	Rename scanning jobs
	Deleting Scanning Jobs


	10.4 IO Bits Monitor
	10.5 Configuring Devices
	10.6 SMC Device Configuration Editor
	Administration Configuration
	Controller Configuration
	Correction Tables
	Laser Configuration
	Lens Configuration
	Performance Adjustments
	10.6.1 User Configuration
	Interlock Configuration
	Scanner Configuration
	ScanPack Configuration


	10.7 Laser Diagnostics

	11 How to Script in ScanScript
	11.1 About Language Construct
	Equals “=”
	Variables
	Variable Types
	Function

	11.2 Control Structures
	if
	while
	for
	repeat
	11.2.1 Operators
	Relational Operators
	Arithmetic Operators
	Coercion
	Logical Operators
	Concatenation
	Precedence
	Associativity


	11.3 ScanScript Commands
	11.4 ScanScript Execution Model
	11.5 To start scripting
	11.5.1 Methods


	12 Extending ScanScript Capabilities through the ScanMaster Designer Extentions Framework
	12.1 Extention Folder
	12.1.1 Sample Script
	12.1.2 Contents of snFile.txt:

	12.2 Send and receive arguments to the ScanMaster API
	12.2.1 System.SendCommand
	12.2.2 System.ReceiveCommand


	13 Appendix
	13.1 Snap Commands
	13.1.1 Snap to Angle
	13.1.2 Snap to Grid
	13.1.3 Snap to Objects
	End Points
	Mid Points
	Center
	Nodes
	Tracking
	Quadrants
	Intersection
	Extension


	13.2 ScanMaster Designer Shortcut Keys

	14 Index

